
UF-7000/7100/8000/8100/9000

Operating Instructions
Software

English

Before operating this software, please read these instructions completely and keep these operating instructions for future reference.

(For Document Management System and Printer)
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The UF-9000 model used throughout this manual for the PC screens is for 
illustration purpose only. The operation is the same for other models as well, therefore, 
when reading this manual substitute with your machine model instead.

The following trademarks and registered trademarks are used throughout this manual: 

Microsoft, MS-DOS, Windows and Windows NT are registered trademarks of Microsoft 
Corporation in the USA and other countries.
i386, i486 and Pentium are trademarks of Intel Corporation.
The USB-IF Logos are trademarks of Universal Serial Bus Implementers Forum, Inc.
TrueType is a registered trademark of Apple Computer, Inc.
Novell and NetWare are registered trademarks of Novell, Inc. in the USA and other countries.
All other trademarks identified herein are the property of their respective owners.

Copyright  c  2004 by Panasonic Communications Co., Ltd.
All rights reserved. Unauthorized copying and distribution is a violation of law.
Published in Japan.

The contents of these Operating Instructions are subject to change without notice.



Table of Contents

External View and Control Panel .................................................................................. 6
� External View ................................................................................................. 6
� Control Panel.................................................................................................. 7

System Requirements.................................................................................................... 9

Installing the Printer Driver ........................................................................................... 10
� Installation Procedures................................................................................... 10
� Connecting with a USB Cable (Windows 98) ................................................. 17
� Connecting with a USB Cable (Windows Me) ................................................ 21
� Connecting with a USB Cable (Windows 2000) ............................................. 24
� Connecting with a USB Cable (Windows XP/Windows Server 2003) ............ 27

Installing the LPR (Line Printer Remote) Monitor ....................................................... 29
� Windows 98/Windows Me .............................................................................. 29
� Windows NT 4.0 ............................................................................................. 33
� Windows 2000/Windows XP/Windows Server 2003 ...................................... 37

Configuring the Printer Driver Settings ....................................................................... 41
� Windows 98/Windows Me .............................................................................. 41
� Windows NT 4.0 (Administrator) .................................................................... 49
� Windows NT 4.0 (User) .................................................................................. 57
� Windows 2000/Windows XP/Windows Server 2003  (Administrator)............. 58
� Windows 2000/Windows XP/Windows Server 2003 (User) ........................... 67
� All Windows Common Settings ...................................................................... 68

Print Operation ............................................................................................................... 74
� Printing from Windows Applications ............................................................... 74
� Printing on Network ........................................................................................ 75

Mailbox and Secure Mailbox ......................................................................................... 77
� General Description........................................................................................ 77
� Printing a File from the Mailbox...................................................................... 78
� Deleting a File from the Mailbox..................................................................... 79
� Printing a File from the Secure Mailbox ......................................................... 80
� Deleting a File from the Secure Mailbox ........................................................ 81

Setting Your Machine..................................................................................................... 82
� Network Parameters....................................................................................... 82
� Printer Settings............................................................................................... 84

Specification ................................................................................................................... 86
� Available Paper Type and Paper Size............................................................ 86
� Available Paper Weight and Capacity ............................................................ 87
� Transparencies and Labels ............................................................................ 88
� Envelopes....................................................................................................... 89
� Loading the Envelopes................................................................................... 91
� Printer Specifications...................................................................................... 92

Before Starting

Printer Section
3



Table of Contents

4

Installing the Document Management System............................................................ 94
Document Manager ........................................................................................................ 98

� Main Window ................................................................................................. 98
� Basic Operations............................................................................................ 100
� Setting Plug-in................................................................................................ 102
� File Menu ....................................................................................................... 103
� Edit Menu....................................................................................................... 110
� View Menu ..................................................................................................... 111
� Document Menu............................................................................................. 112
� Options Menu................................................................................................. 114

Image Converter ............................................................................................................. 115
� General Description ....................................................................................... 115
� Windows 98/Windows Me.............................................................................. 115
� Windows NT 4.0............................................................................................. 116
� Windows 2000/Windows XP/Windows Server 2003...................................... 117

Document Viewer ........................................................................................................... 118
� Main Window ................................................................................................. 118
� Basic Operations............................................................................................ 120
� Annotation Function ....................................................................................... 121
� File Menu ....................................................................................................... 122
� Edit Menu....................................................................................................... 127
� Page Menu..................................................................................................... 128
� View Menu ..................................................................................................... 131
� Annotation Menu............................................................................................ 132
� Window Menu ................................................................................................ 141

Network Scanner ............................................................................................................ 142
� Network Scanner Settings ............................................................................. 142
� Panasonic Communications Utility................................................................. 145
� Remote Copy (DP-180/190 and UF-9000 only) ............................................. 146

Panafax Desktop ............................................................................................................ 149
� General Description ....................................................................................... 149
� Connection Configurations (For the Network Connected Models)................. 150
� Connection Configurations (For Local Connected Models) ........................... 152
� Installation and Setup (For the Network Connected Models) ........................ 154
� Installation and Setup (For the Local Connected Models) ............................. 163
� Main Window and Toolbar ............................................................................. 167
� Sending Document ........................................................................................ 169
� Receiving Document ...................................................................................... 173
� Registering the Personal Phone Book ........................................................... 174
� Cover Sheet ................................................................................................... 179
� Configuration Menu........................................................................................ 182
� Send Log/Receive Log................................................................................... 184

Network Status Monitor ................................................................................................. 187
� Network Device Locator ................................................................................. 187
� Task Display .................................................................................................. 189
� Taskbar Menu ................................................................................................ 190
� Job Completion Notice................................................................................... 196

Document Management System Section



Table of Contents
Network Configuration Editor/Address Book Editor................................................... 198
� General Description........................................................................................ 198
� Activation Procedure ...................................................................................... 199
� Create Shortcut Links..................................................................................... 200
� Main Window.................................................................................................. 201
� Basic Operation.............................................................................................. 203
� Advanced Operation....................................................................................... 206

Troubleshooting ............................................................................................................. 216
� Printing Operation Failure .............................................................................. 216
� Document is Not Printed Correctly ................................................................. 217
� Error Messages Displayed on the Computer ................................................. 218

Appendix ......................................................................................................................... 219
� Printing Area................................................................................................... 219

Document Management System Section

Troubleshooting

Appendix
5



6

Before Starting

External View and Control Panel

� UF-7000/7100/8000/8100

� UF-9000

External View

(USB cable is not included with the product)         
For peak performance and optimal data transmission, 
purchase an Universal Serial Bus (USB) Hi-Speed Cable. 
Consult with your service provider for further details.
Note:   The USB port is only available for printing.

USB Cable

LAN Cable (10Base-T/100Base-TX Cable)
(LAN cable is not included with the product) 
Purchase a Category 5 (CAT 5) Cable, 
compliant with EIA/TIA 568-A-5 standard.
Connect to your 10Base-T/100Base-TX Ethernet Network.

(USB cable is not included with the product)         
For peak performance and optimal data transmission, 
purchase an Universal Serial Bus (USB) Hi-Speed Cable. 
Consult with your service provider for further details.
Note:   The USB port is only available for printing.
.

USB Cable

LAN Cable (10Base-T/100Base-TX Cable)
(LAN cable is not included with the product) 
Purchase a Category 5 (CAT 5) Cable, 
compliant with EIA/TIA 568-A-5 standard.
Connect to your 10Base-T/100Base-TX Ethernet Network.
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� UF-7000/8000

� UF-7100/8100

NOTE 1. Function setting is accessible only when the machine is in the Ready Mode.

Control Panel

No. Name Function
STOP Key Used to cancel the print job.

Note: Make sure that the PRINT lamp is ON and printer is 
on line.

If not, press  button in advance to 
cancel the print job.

Mailbox  
 (See page 77)

Secure Mailbox
 (See page 80)

Job Control
1. Printer Status

• Online
• Offline

2. Print Cancel
Note: Make sure that the PRINT lamp is ON and the 

printer is on line to cancel the print job.

Printer Settings (See page 84)

1

PRINT
7
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Control Panel

� UF-9000

NOTE 1. Function setting is accessible only when the machine is in the Ready Mode.

No. Name Function
ON LINE LED Lit : Printer is Online.

Off : Printer is Offline.

STOP Key Used to cancel the print job.
Note: Make sure that the PRINT lamp is ON and printer is 

on line.

If not, press  button in advance to 
cancel the print job.

Mailbox  
 (See page 77)

Secure Mailbox
 (See page 80)

Job Control
1. Printer Status

• Online
• Offline

2. Print Cancel

Note: Make sure that the PRINT lamp is ON and the 
printer is on line to cancel the print job.

Printer Settings (See page 84)

1

2

PRINT
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System Requirements

• Personal Computer : IBM PC/AT and compatibles (CPU Pentium II or greater)
• Operating System : Windows 98*1, Windows Me*2, Windows NT 4.0*3 (With Service Pack 3 or later is

required), Windows 2000*4, Windows XP*5, Windows Server 2003*6

• System Memory : The minimum recommended Memory for each OS is as follows:

• Free Disk Space : 100 MB or more.
• CD-ROM Drive : Used for installing the software and utilities from the CD-ROM.
• Interface : 10Base-T/100Base-TX Ethernet port, USB port

* 1 Microsoft® Windows® 98 operating system (hereafter Windows 98)
* 2 Microsoft® Windows® Millennium Edition operating system (hereafter Windows Me)
* 3 Microsoft® Windows NT® operating system Version 4.0 (hereafter Windows NT 4.0)
* 4 Microsoft® Windows® 2000 operating system (hereafter Windows 2000)
* 5 Microsoft® Windows® XP operating system (hereafter Windows XP)
* 6 Microsoft® Windows Server ™ 2003 operating system (hereafter Windows Server 2003)

Windows 98, Windows Me : 64 MB or greater
Windows 2000, Windows XP, Windows NT 4.0, 
Windows Server 2003 

: 128 MB or greater
9
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Printer Section

Installing the Printer Driver

This manual provides examples of instructions for installing, configuring and using the printer driver for your
version of Windows OS.

To use as a USB Printer:

To use as a Network Printer:

Installation Procedures

Windows 98 : Follow the procedures on pages 17 to 20. (Connecting with a USB Cable)
Windows Me : Follow the procedures on pages 21 to 23. (Connecting with a USB Cable)
Windows NT : This Windows OS does not support a USB Printer.
Windows 2000 : Follow the procedures on pages 24 to 26. (Connecting with a USB Cable)
Windows XP/
Windows Server 2003

: Follow the procedures on pages 27 to 28. (Connecting with a USB Cable)

Windows 98 : Follow the procedures on pages 11 to 16 (Installing the Printer Driver) and 
then pages 29 to 32 (Installing the LPR Monitor).

Windows Me : Follow the procedures on pages 11 to 16 (Installing the Printer Driver) and 
then pages 29 to 32 (Installing the LPR Monitor).

Windows NT : Follow the procedures on pages 11 to 16 (Installing the Printer Driver) and 
then pages 33 to 36 (Installing the LPR Monitor).

Windows 2000 : Follow the procedures on pages 11 to 16 (Installing the Printer Driver) and 
then pages 37 to 40 (Installing the LPR Monitor).

Windows XP/
Windows Server 2003

: Follow the procedures on pages 11 to 16 (Installing the Printer Driver) and 
then pages 37 to 40 (Installing the LPR Monitor).
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1 START_98 Insert the Panasonic Document Management 
System CD-ROM.

2 Click on the desired language.

Note: If the CD-ROM does not launch 
automatically, double click the My 
Computer icon on the Desktop or on 
the Start menu, then double click the 
CD-ROM icon. 

3 Click the  button.

4 Click Printer Driver.

5 Note for Windows 98/Windows Me users:
If your computer does not have the LPR Port 
Monitor installed, please proceed to "Installing 
the LPR Monitor" on page 29 before 
continuing this installation.

Click Install Printer Driver.

Next
11Continued on the next page...



Installing the Printer Driver

12
6 Select Local Printer and click the 

 button.

7 Select your machine's model(s) check box 

and click the  button.

8 Select how your machine will be used, either 
as a Network Printer or as a USB Printer.

If USB Printer is selected, click the 

 button and skip to Step 13.

Note: Make sure that the Power Switch of 
your machine is OFF and the USB 
cable is not connected to your 
computer.

9 Check LPT1: and click the  

button.

Next

Next

Next

Next
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10 Click the  button if you would like 

to change your current default printer to the 
one that you are installing.

Note: This dialog box only appears if another 
printer is already installed.

11 Select your new default printer from the New 

Printer List and click the  button.

12 The required files are copied.

13a USB Printer Only
<Windows 98, Windows Me>
When this message appears, turn the Power 
Switch of your machine ON and connect your
machine to an available USB Port on your 
computer.

Note: (For Windows 98 users)
If your PC does not detect the device, 
and a dialog box does not appear 
confirming its detection after the USB 
cable is connected, proceed as follows:
1. Locate the DrvIns.exe file under the 

D:\Tools\DrvUnIns directory on the 
CD-ROM and execute the file to 
delete the Printer Driver (where "D:" 
is your CD-ROM drive).

2. Follow the procedures on pages 17 
to 20 to reinstall the Printer Driver.

Yes

Next
13Continued on the next page...
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13b USB Printer Only
<Windows 2000>

Click the  button.

When this message appears, turn the Power
Switch of your machine ON and connect your
machine to an available USB Port on your
computer.

Click the  button.

13c USB Printer Only
<Windows XP/Windows Server 2003>

Click the  button.

Yes

Yes

Continue Anyway
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13c When this message appears, turn the Power 
Switch of your machine ON and connect your 
machine to an available USB Port on your 
computer.

<Windows XP Service Pack 2>
Select No, not this time  and click the 

 button.

Select Install the software automatically  

and click the  button.

This message may appear if you have a 
previous version of the printer driver installed.
Select the latest version of the ∗.inf file and 

click the  button.

Next

Next

Next
15Continued on the next page...



Installing the Printer Driver

16
The Panasonic/Panafax Printer Driver have been installed, and the Panasonic/Panafax Printer icon(s) have
been added to the Printer folder.

If you are installing the Printer Driver for network printing, please contact your network administrator for the
IP Address of the machine and proceed to the next section to install the LPR Monitor service for the version
of Windows you are using after your computer has rebooted.

NOTE 1. When installing on Windows NT 4.0, Windows 2000 , Windows XP or Windows Server 2003, 
logon to the computer/network using an account with administrator rights.

2. To remove the Printer Driver, select  Panasonic UF-XXXX in Add/Remove Programs

Properties in the Control Panel and click the  /  button.

13c Click the  button.

Click the  button.

14 When the setup process is completed, a 
message is displayed prompting you to restart 
your computer.

Click the  button to restart your 

computer.
END_win

Continue Anyway

Finish

Finish

Add... Remove
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To use the printer by means of a USB cable connection, install the printer driver by following the steps
below. 

Connecting with a USB Cable (Windows 98)

1 Connect the printer to the PC with an USB cable.
Turn the Power Switch of your machine ON.

2 The New Hardware Found dialog box appears for 
a brief moment, followed by the Add New 
Hardware Wizard dialog box.

Click the  button.

3 Select Search for the best driver for your 
device.

Click the  button.

4 Insert the CD-ROM included in your machine.

(Rear View)

(Rear View)

Next

Next
17Continued on the next page...
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Connecting with a USB Cable (Windows 98)
5 Select Specify a location and type
D:\English\PanaDMS\Driver\UsbDrv\Win9x

(where "D:" is your CD-ROM drive).

Click the  button.

6 Click the  button.

7 Click the  button.

8 The New Hardware Found dialog box appears for 
a brief moment, followed by the Add New 
Hardware Wizard dialog box.

Click the  button.

Next

Next

Finish

Next
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Connecting with a USB Cable (Windows 98)
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9 Select Search for the best driver for your 
device.

Click the  button.

10 Select Specify a location  and type 
D:\English\PanaDMS\Driver\Win9x

(where "D:" is your CD-ROM drive).

Click the  button.

11 Click the  button.

12 Enter the Printer name and click the  

button.

Next

Next

Next

Finish
19Continued on the next page...
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Connecting with a USB Cable (Windows 98)
13 Click the  button.

END_USB_98

Finish



Installing the Printer Driver

Pr
in

te
r S

ec
tio

n

Connecting with a USB Cable (Windows Me)

1 Connect the printer to the PC with an USB cable.
Turn the Power Switch of your machine ON.

2 The New Hardware Found dialog box appears for 
a brief moment, followed by the Add New 
Hardware Wizard dialog box.

Select Specify the location of the driver.
 (Advanced).

Click the  button.

3 Insert the CD-ROM included in your machine.

4 Select Specify a location  and type 
D:\English\PanaDMS\Driver\UsbDrv\Win9x

(where "D:" is your CD-ROM drive).

Click the  button.

(Rear View)

(Rear View)

Next

Next
21Continued on the next page...
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Connecting with a USB Cable (Windows Me)
5 Click the  button.

6 Click the  button.

7 The New Hardware Found dialog box appears for 
a brief moment, followed by the Add New 
Hardware Wizard dialog box.
Select Specify the location of the driver.
 (Advanced).

Click the  button.

8 Select Specify a location  and type 
D:\English\PanaDMS\Driver\Win9x

(where "D:" is your CD-ROM drive).

Click the  button.

Next

Finish

Next

Next
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9 Click the  button.

10 Enter the Printer name and click the 

button.

11 Click the  button.

END_USB_me

Next

Finish

Finish
23
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Connecting with a USB Cable (Windows 2000)

1 Connect the printer to the PC with an USB 
cable.
Turn the Power Switch of your machine ON.

2 The Found New Hardware Wizard dialog box 
appears.

Click the  button.

3 Select Search for a suitable driver for my 
device.

Click the  button.

(Rear View)

(Rear View)

Next

Next
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Connecting with a USB Cable (Windows 2000)
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4 Insert the CD-ROM included in your machine.

5 Select Specify a location.

Click the  button.

6 Type 
D:\English\PanaDMS\Driver\WinXP-2K-2003

(where "D:" is your CD-ROM drive).

Click the  button.

7 Click the  button.

8 Click the  button.

Next

OK

Next

Yes
25Continued on the next page...
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Connecting with a USB Cable (Windows 2000)
9 Click the  button.

END_USB_2000

Finish
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Connecting with a USB Cable (Windows XP/Windows Server 2003)

1 Connect the printer to the PC with an USB 
cable.
Turn the Power Switch of your machine ON.

2 <Windows XP Service Pack 2>
Select No, not this time  and click the 

 button.

3 The Found New Hardware Wizard dialog box 
appears.
Select Install from a list or specific location 
(Advanced).

Click the  button.

(Rear View)

(Rear View)

Next

Next
27Continued on the next page...
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Connecting with a USB Cable (Windows XP/Windows Server 2003)
4 Select Include this location in the search.
Type 
D:\English\PanaDMS\Driver\WinXP-2K-2003

(where "D:" is your CD-ROM drive).
Insert the CD-ROM included in your machine.

Click the  button.

5 This message may appear if you have a 
previous version of the printer driver installed.

Select the latest version of the ∗.inf file and 

click the  button.

6 Click the  button.

7 Click the  button.

END_USB_XP/2003

Next

Next

Continue Anyway

Finish
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Installing the LPR (Line Printer Remote) Monitor

Windows 98/Windows Me

1 Insert the Panasonic Document Management 
System CD-ROM.

2 Click on the desired language.

Note: If the CD-ROM does not launch automatically, 
double click the My Computer icon on the 
Desktop or on the Start menu, then double 
click the CD-ROM icon. 

3 Click the  button.

4 Click Printer Driver.

5 Click Install LPR Monitor.

Next
29Continued on the next page...
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Windows 98/Windows Me
6 The M-LPR Port Monitor Setup dialog box 
appears.

Click the  button.

7 The required files are copied.

8 The setup program copies the necessary files onto
the hard disk of your PC.
When the setup process is completed, a message
is displayed prompting you to restart your
computer.
It is recommended that you restart your computer
now so that the LPR Monitor can be started.

Click the  button.

9 If you have not installed the printer driver yet, please 
proceed to "Installing the Printer Driver" on page 10.

After your computer has rebooted, click the Start 
button, select Settings, and then click Printers.

The Printers folder appears.

Right-click on the desired printer icon and select 
Properties from the pop-up menu.

OK

Finish
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Windows 98/Windows Me
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10 The printer properties dialog box appears.

The following step registers the LPR Port for network 
printing.

Before proceeding, ensure that the printer is 
installed, connected to the network, turned ON and is 
operating properly.

11 Select the Details tab and click the  

button.

12 The Add Port dialog box appears. Click the Other 
radio button, select M-LPR Port Monitor from "Click 
the type of port you want to add:" list, and click the 

 button.

Add Port...

OK
31Continued on the next page...
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Windows 98/Windows Me
NOTE 1. To print data via LAN, the LPR Monitor must be installed on your PC.

13 The M-LPR Port Monitor dialog box appears.

Type the IP Address of the machine in the Host 
name or IP address window and the queue name 
(e.g. New105) in the Queue name: text box.

Click the  button. If an error occurs 

because the queue name had already been used for 
the same IP Address, select a different unique name 
such as "New106".

14 The screen reverts to the Printer Properties.

Check that the "Print to the following port:" has been 
changed as entered in step 13, and click the 

 button first and then the  

button.

The printer properties dialog box closes and you 
have now configured the printer as a network printer.
END_LPR_98

OK

Apply OK
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Logon using an account with administrator rights.

Windows NT 4.0

1 Click the Start button, select Settings, and click 
Control Panel.

The Control Panel window appears.

Double-click on the Network applet.

The Network dialog box appears.

2 Click the Services tab.

Verify whether the LPR Service is already installed.
(Indicated by Microsoft TCP/IP Printing shown in 
the Network Services list.)

If it is already installed, skip to Step 7. Otherwise 
continue installing the LPR Service.

3 Click the  button to display the Select 

Network Service dialog box, and select Microsoft 
TCP/IP Printing.

Click the  button.

Add...

OK
33Continued on the next page...
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Windows NT 4.0
4 The Windows NT Setup dialog box appears.

Insert the Windows NT 4.0 CD-ROM, and type 
D:\i386 (where "D:" is your CD-ROM drive).

Click the  button.

5 After the files have been copied into the hard drive of 
your PC, the display returns to the Network dialog 
box. Confirm that the Microsoft TCP/IP Printing 
service has been added to Network Services list.

Click the  button.

Note: If the OK button does not change into a 
Close button, remove and reinstall the 
Microsoft TCP/IP Printing service. 

6 When Network Settings Change dialog box is 

displayed, click the  button to restart 

your computer now.

You have now completed the LPR Service 
installation.

7 After your computer has rebooted, logon with an 
account with Administrator Privileges, click the Start 
button, select Settings, and then click Printers.

The Printers folder appears.

Right-click on the desired printer icon and select 
Properties from the pop-up menu.

Continue

Close

Yes
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Windows NT 4.0
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8 The following step registers the LPR Port for network 
printing.

Before proceeding, ensure that the printer is 
installed, connected to the network, turned ON and is 
operating properly.

Select the Ports Tab and click the   

button.

9 The Printer Ports dialog box appears.

Select LPR Port and click the  

button.

10 The Add LPR compatible printer dialog box 
appears.

Enter the IP Address of the printer in the upper field, 
and "lp" for the print queue name in the lower field.

Click the  button.

(Please wait while the wizard verifies the IP Address 
and connectivity to the network)

Add Port...

New Port

OK
35Continued on the next page...
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Windows NT 4.0
11 The Printer Ports dialog box appears.

Click the  button.

12 Select the printer port and click the  

button.

The printer properties dialog box closes and you 
have now configured the printer as a network printer.
END_LPR_NT

Close

OK
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Logon using an account with administrator rights.

Windows 2000/Windows XP/Windows Server 2003

1 Open the Printers (Windows XP/Windows 
Sever 2003: Printers and Faxes) folder.

Right-click on the desired printer icon and 
select Properties from the pop-up menu.

The printer properties dialog box appears.

2 Select the Ports Tab and click the  

 button.Add Port...
37Continued on the next page...
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Windows 2000/Windows XP/Windows Server 2003
3 Select Standard TCP/IP Port and click the 

 button.

4 Click the  button.

5 Enter the IP Address and the Port Name and 

click the  button.

Note: The Port Name is automatically 
entered together with the IP Address. 
You may need to change it as 
required.

New Port ...

Next

Next
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Windows 2000/Windows XP/Windows Server 2003
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6 Select Custom and click the  

button.

7 1. In the Protocol section, select LPR.
2. In the LPR Settings section, enter the 

Queue Name (e.g. LPR1) and select the 
LPR Byte Counting Enabled.

3. Click the  button.

8 Click the  button.

Settings...

OK

Next
39Continued on the next page...
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Windows 2000/Windows XP/Windows Server 2003
9 Click the  button.

10 Click the  button.

11 Click the  button.

Click the  button.

The printer properties dialog box closes and 
you have now configured the printer as a 
network printer.
END_LPR_2000

Finish

Close

Apply

OK
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Configuring the Printer Driver Settings

To change the printer settings, open the dialog box for the printer properties by performing the following
steps.

Windows 98/Windows Me

1 Click the Start button, select Settings, and then click 
Printers.

2 Right-click on the desired printer icon in the Printers 
folder, and select Properties in the pop-up menu.

The printer properties dialog box appears.
41
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Windows 98/Windows Me

General Tab

1. Comment
Enter comments to the properties, if any.

If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an existing user will remain
unchanged even if this comment is modified later.

2. Separator page
This feature does not function properly on your machine. We recommend that you do not use it.

3.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

Print Test Page



Configuring the Printer Driver Settings

Windows 98/Windows Me

Pr
in

te
r S

ec
tio

n

Details Tab

1. Print to the following port
Displays either the port where the printer is connected or the path to the network printer.

To change the printing destination, either select the printing destination port from the list or enter the
network path here.

2. Print using the following driver
Displays the type of the printer driver. Specify the printer being used or a printer model which can be
emulated with the printer being used.

3.  /  button
Assigns a local port to the network connected printer or cancels a local port assigned to the network
printer.

4. Timeout settings - Not selected
Specify the amount of time (in seconds) allowed to elapse before the printer comes online. If the printer is
not online within this duration, an error message will be displayed.

5. Timeout settings - Transmission retry
Specify the amount of time (in seconds) allowed to elapse before the printer is ready for printing. If the
printer is not ready for printing within this duration, an error message will be displayed.

Increase this value if a timeout error occurs when printing a large document.

6.  /  button
Adds/deletes a new port or a new network path.

7.  button
Updates or modifies the printer driver.

UF-9000

Capture Printer Port... End Capture...

Add Port... Delete Port...

New Driver...
43Continued on the next page...
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Windows 98/Windows Me
8.  button
Specify the method of sending (spooling) documents from the program to the printer.

9.  button
Modifies printer port settings.

Spool Settings...

Port Settings...
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Sharing Tab 

1. Not Shared/Shared As
Select whether to display or share this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as is or a new name may be
entered. The name specified here will be displayed when other users view information about the printer
on the network.

3. Comment
You can enter comments regarding a shared printer (such as the type of printer and the location where it
is installed). When other users view information about the printer on the network, the comment specified
here will be displayed.

4. Password
Specify the password required when other users will connect to this printer.
Leave the box blank in order not to use any password.

NOTE 1. Sharing Tab in property dialog box is not displayed unless printer sharing has been specified.
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Windows 98/Windows Me

Device Options Tab

1. SD Memory Card (256MB or greater) / HDD
Select Installed if the SD Memory Card (256MB or 512MB) is installed. (UF-7000/7100/8000/8100)
Select Installed if the HDD Unit is installed. (UF-9000)

2.  button
When your machine is connected onto the network (TCP/IP), click this button to set the Options 
Configuration automatically.

3. Number of Paper Trays
Select the number of available paper trays if optional Paper Feed Module(s) are installed.

4.  button

Edit the URL address that will be displayed when clicking the  button of the Paper 
Tab (see page 69).

<UF-7000/7100/8000/8100> <UF-9000>

Auto Configuration

Edit URL...

Support Contacts (W)...
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NOTE 1. Device Options Tab specifies device-specific settings and settings of optional devices. 
Make sure that the Device Option Tab is set properly before printing a document, or printing
 problems may occur.

URL Title
Enter an applicable URL title.

URL
Enter the URL address to be associated to the 

  button of the Paper Tab. 
(See page 69)

Contact
Enter applicable contact information
(i.e.: The email address of the contact person)

Support Contacts (W)...
47
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Windows 98/Windows Me

Paper/Output/Quality/Secure Tab 

Refer to All Windows Common Settings (see pages 68 - 73).
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To change the printer settings, open the dialog box for the printer properties by performing the following
steps.

NOTE 1. In Windows NT 4.0, setting of the properties depends on the logon account. This section
describes properties to be specified by the administrator (system manager).
See "Configuring the Printer Driver Settings (User)" for details on user properties.  (See page
57)

Windows NT 4.0 (Administrator)

1 Logon to the computer/network using an account with
administrator rights. (See Note 1)

2 Click the Start button, select Settings, and then click the
Printers icon.

3 Right-click on the desired printer icon in the Printers
folder, and select Properties in the popup menu.

The printer properties dialog box appears.
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Windows NT 4.0 (Administrator)

General Tab

1. Comment
Enter comments to the properties, if any.

If another user sets up this printer on his or her computer when sharing the printer, the comment specified
here will also appear on that computer. However, the comment displayed for an existing user will remain
unchanged even if this comment is modified later.

2. Location
Specifies the printer location.

3. Driver
Displays the printer driver type. Specify the printer being used or a printer model that can be emulated
with the printer being used.

4.  button
Updates or modifies the printer driver.

5.  button
This feature does not function properly on your machine. We recommend that you do not use it.

6.  button
Specify the processor to be used for printing (Print Processor) and the data type (Default Data type).

The processor and data type affect the manner in which the printer functions in Windows NT. Normally
they do not need to be modified. However, modification might be necessary when the printer is used with
a special application.

7.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

New Driver...

Separator Page...

Print Processor...

Print Test Page
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Ports Tab

1. Print to the following port(s)
Displays a list of available ports for printing (Port), their status (Description) and printers that are
connected to these ports (Printer).

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configures the selected port. In case of a parallel port, Transmission Retry should be specified. (See 
Note 1 and 2)

4. Enable bidirectional support
This setting enables reception of configuration data and status data from the printer.

5. Enable printer pooling
Printer pooling allows data sent to one logical printer to be received and printed by two or more printers. 
With printer pooling enabled, a transmitted printing job is output to the first printer that is ready for 
printing.

NOTE 1. Specify the waiting time (seconds) for the printer to be ready for printing. If the printer is not
ready for printing after the specified time has elapsed, an error message is displayed.

2. If a timeout error occurs frequently upon printing a large size document, specify a larger value
here.

Add Port... Delete Port

Configure Port...
51



Configuring the Printer Driver Settings

52

Windows NT 4.0 (Administrator)

Scheduling Tab

1. Available
Schedules when the printer is available for operation. Specify operating hours when From-To is selected.

2. Priority
Sets printing priority. The slider allows the priority to be adjusted from 1 through 99.

3. Spool print documents... / Print directly to the printer
Specify how documents should be sent from an application to the printer.

4. Hold mismatched documents
This feature does not function properly on your machine. We recommend that you do not use it.

5. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

6. Keep documents after they have printed
Holds documents in the print queue even after they have been printed. These documents can be printed
again directly from the queue regardless of the state the application is in.
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Sharing Tab

1. Not Shared/Shared
Select whether to display or share this printer with other computers.

2. Share Name
Specify the name of the shared printer. The displayed name can be used as it is or a new name may be 
entered. The name specified here will be displayed when other users view information about the printer 
on the network.

3. Alternate Drivers (See Note 1)
Allows other operating systems' printer drivers to be loaded.  When users of these operating systems 
connect to the printer, the printer driver is automatically loaded.

NOTE 1. When sharing a printer on the network, the print driver needs to be installed on the print server
only, and other computers will automatically copy and use that driver.
For this reason, the print server must be ready with printer drivers for all the operating systems
of all the computers that will be sharing the printer.
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Windows NT 4.0 (Administrator)

Security Tab 

1.  button
Set printer access privileges.

2.  button
Displays the users who have used this printer and how they used it.

3.  button
Set the ownership of the printer.

NOTE 1. In order to utilize these features, first you need to select Audit from User Manager's Policies
and enable File and Object Access in the Audit Policy dialog box.

Permissions

Auditing

Ownership



Configuring the Printer Driver Settings

Windows NT 4.0 (Administrator)

Pr
in

te
r S

ec
tio

n

Device Options Tab

1. SD Memory Card (256MB or greater) / HDD
Select Installed if the SD Memory Card (256MB or 512MB) is installed. (UF-7000/7100/8000/8100)
Select Installed if the HDD Unit is installed. (UF-9000)

2. Halftone Setup

 button
Select the halftoning method to be used (halftones specific to the printer).
Select it according to the details of the data and your preference.

• Halftone Pattern
Select the pixel size to be used for halftones.
The greater the value, the coarser the image would become. However, a larger value is suited for 
printing large areas.
The Enhanced pattern allows printing at a higher resolution using the same number of pixels. However, 
the pattern might generate unnatural lines, patterns, moire effects, and so on depending on the image to 
be printed.

<UF-7000/7100/8000/8100> <UF-9000>

Halftone Setup...
55Continued on the next page...



Configuring the Printer Driver Settings

56

Windows NT 4.0 (Administrator)

• Device Gamma

Adjust the gamma of print images (color intensities).

• Pixel Diameter
Adjust the darkness of the print image. Move the slider to specify the pixel size. You can choose 
between specifying the real size in inches or specifying it as a percentage relative to the printer 
resolution.

• Luminance (CIE Y)
Adjust the luminosity of the print image.

3.  button
When your machine is connected onto the network (TCP/IP), click this button to set the Options 
Configuration automatically.

4. Number of Paper Trays
Select the number of available paper trays if optional Paper Feed Module(s) are installed.

5.  button

Edit the URL address that will be displayed when clicking the  button of the Paper 
Tab (see page 69).

NOTE 1. Device Options  Tab specifies device-specific settings and settings of optional devices.
Make sure that the Device Option Tab is set properly before printing a document, or printing  
problems may occur.

URL Title
Enter an applicable URL title.

URL
Enter the URL address to be associated to the 

  button of the Paper Tab. 
(See page 69)

Contact
Enter applicable contact information
(i.e.: The email address of the contact person)

Auto Configuration

Edit URL...

Support Contacts (W)...

Support Contacts (W)...
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To change the printer settings, open the dialog box for the printer properties by performing the following
steps.

NOTE 1. In Windows NT 4.0, setting properties depends on the logon account. This section describes
properties to be specified by a user, upon executing a print operation in an application. See
"Configuring the Printer Driver Settings (Administrator)" for details on administrator properties.
(See page 49)

Windows NT 4.0 (User)

1 Select Print in the File menu of the application.

2 Select the printer model in the name list box.

3 Click the  button in the Print dialog box.

4 The printer properties dialog box appears. Click the
desired tabs of the dialog box and specify the properties.
(See Note 1)
(See pages 68 - 73)

Properties...
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To change the printer settings, open the dialog box for the printer properties by performing the following
steps.

NOTE 1. In Windows 2000/Windows XP/Windows Server 2003 , setting of the properties depends on 
the logon account. This section describes properties to be specified by the administrator 
(system manager). See "Configuring the Printer Driver Settings" for details on user properties. 
(See page 67)

Windows 2000/Windows XP/Windows Server 2003  (Administrator)

1 Logon to the computer/network using an account with
administrator rights.

2 Click the Start button, select Settings, and then click the 
Printers (Windows XP/Windows Server 2003: Printers 
and Faxes) icon.

3 Right-click on the desired printer icon in the Printers
folder, and select Properties in the popup menu.

The printer properties dialog box appears. (See Note 1)
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General Tab

1. Printer Name
Name of the printer specified upon installation is displayed.

2. Location and Comment
Enter a comment about the location of the printer and information about the printer.

If a printer is shared, the location and comments specified in this field appear when another user sets up
this printer on his/her computer. After completion of setup, however, changing this comment does not
update the location and comment appearing on users PCs.

3. Model
Model name of the printer is displayed.

4. Features
Functions and settings of the printer are displayed.

5.  button
Changes properties (print settings) specifiable for each user.
Refer to "Configuring the Printer Driver Settings (User)" for details on settings (see page 67).

6.  button
Prints a test page. This allows the user to verify if the printer is installed properly.

Printing Preferences...

Print Test Page
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Windows 2000/Windows XP/Windows Server 2003 (Administrator)

Sharing Tab

1. Not Shared/Shared As  (Do not share this printer/Share this printer)
Specify if this printer is displayed or shared with other computers.

For sharing a printer, specify the share name of a printer. A name specified here appears when other 
users view the printer information on a network.

2.  button
Install additional printer drivers on the system. (See Note 1)

When users running different versions of Windows share a printer, installing additional drivers avoids the 
need for installing new drivers on their systems.

NOTE 1. When sharing a printer on the network, the print driver needs to be installed on the print server
only, and other computers will automatically copy and use that driver.
For this reason, the print server must be ready with printer drivers for all the operating systems
of all the computers that will be sharing the printer.

2. If the Windows is set to disable remote access to your PC for the security purpose, the
Windows ask you to activate the Network Setup Wizard. Follow the messages to enable the
Sharing Tab.

<Windows 2000> <Windows XP/Windows Server 2003>

Additional Drivers...
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Ports Tab

1. Print to the following port(s)
Displays a list of ports that allow printing, their status (description), and printers connected to the ports.

2.  /  button
Adds/deletes a new port or a new network path.

3.  button
Configure the port that is selected. On a parallel port, wait time (in seconds) for retransmission is
specified. (See Notes 1 and 2)

4. Enable bidirectional support
This setting enables reception of configuration data and status data from the printer.

5. Enable printer pooling
Printer pooling allows data sent to one logical printer to be received and printed by two or more printers.
With printer pooling enabled, a transmitted printing job is output to the first printer that is ready for
printing.

NOTE 1. Specify the waiting time (seconds) for the printer to be ready for printing. If the printer is not
ready for printing after the specified time has elapsed, an error message is displayed.

2. If a timeout error occurs frequently upon printing a large size document, specify a larger value
here.

Add Port... Delete Port

Configure Port...
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Windows 2000/Windows XP/Windows Server 2003 (Administrator)

Advanced Tab

1. Always available/Available from
Specify the operating schedule for a printer. Selecting Available from allows specifying an available 
operation time.

2. Priority
Specify the priority in printing. Priority is adjustable from 1 to 99. Documents of higher priority are printed 
before those of lower priority.

3. Driver
Displays the printer driver type. Specify the printer being used, or a printer model that can be emulated 
with the printer being used.

4.  button
Updates or modifies the printer driver.

5. Spool print documents so program finishes printing faster
Specify the method of sending a document from the program to the printer.

6. Print directly to the printer
Specify that the document should be sent directly to the printer device and not spooled. Use this if you 
cannot print using either of the print spooling options.

7. Hold mismatched documents
This feature does not function properly on your machine. We recommend that you do not use it.

8. Print spooled documents first
Always prints spooled documents first regardless of printing priority.

9. Keep printed documents
After printing, documents are kept in the queue. The documents are allowed to be reprinted directly from 
the queue regardless of the status of an application.

New Driver...
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10.Enable advanced printing features
Enables advanced printing features. Optional features of the printer (page ordering, booklet printing,
numbering on sheets) are enabled. These features can be disabled if a problem occurs due to
incompatibility. Disabling the features may also disable the printing options.

11.  button
Specifies standard (default) values for the properties (print settings) specifiable for each user. If a local
printer is shared, the settings here are used as printing defaults for other users.

Refer to "Configuring the Printer Driver Settings (User)" for detailed settings.  (See page 67)

12.  button
Specify a print processor and data type to be used for printing.

The processor and data type define operations of printers under Windows 2000/Windows XP/Windows
Server 2003.

Usually no change is required in the settings. Use of a printer from some applications, however, may
require changes in the settings.

13.  button
This feature does not function properly on your machine. We recommend that you do not use it.

Printing Defaults...

Print Processor...

Separator Page...
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Windows 2000/Windows XP/Windows Server 2003 (Administrator)

Security Tab 

Displays a list of users and groups to whom printer access is assigned to. A list of standard permissions for
each group or user is displayed. Check or uncheck the checkboxes for permitting or prohibiting access.
Gray checkbox indicates the permission inheritance.

1.  /  button
Add or delete a user or group from the list.

2.  button
Specify access to a printer, audit, and owner. (See Note 1 and 2)

NOTE 1. Windows 2000 provides the capability of managing access to various objects (e.g. printers) by
users.

2. Refer the Windows 2000 documentation for details on access permission, audit, and owner.
3. Windows XP/Windows Server 2003 users should refer to the documentation to enable the

Security Tab if this tab is not shown on your PC.

Add... Remove

Advanced...
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Device Options Tab

1. SD Memory Card (256MB or greater) / HDD
Select Installed if the SD Memory Card (256MB or 512MB) is installed. (UF-7000/7100/8000/8100)
Select Installed if the HDD Unit is installed. (UF-9000)

2. Halftone Setup

 button
Select the halftoning method to be used (halftones specific to the printer).
Select it according to the details of the data and your preference.

• Halftone Pattern
Select the pixel size to be used for halftones.
The greater the value, the coarser the image would become. However, a larger value is suited for 
printing large areas.
The Enhanced pattern allows printing at a higher resolution using the same number of pixels. However, 
the pattern might generate unnatural lines, patterns, moire effects, and so on depending on the image to 
be printed.

• Device Gamma
Adjust the gamma of print images (color intensities).

<UF-7000/7100/8000/8100> <UF-9000>

Halftone Setup...
65Continued on the next page...
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Windows 2000/Windows XP/Windows Server 2003 (Administrator)

• Pixel Diameter

Adjust the darkness of the print image. Move the slider to specify the pixel size. You can choose 
between specifying the real size in inches or specifying it as a percentage relative to the printer 
resolution.

• Luminance (CIE Y)
Adjust the luminosity of the print image.

3.  button
When your machine is connected onto the network (TCP/IP), click this button to set the Options 
Configuration automatically.

4. Number of Paper Trays
Select the number of available paper trays if optional Paper Feed Module(s) are installed.

5.  button

Edit the URL address that will be displayed when clicking the  button of the Paper 
Tab (see page 69).

NOTE 1. Device Options  Tab specifies device-specific settings and settings of optional devices.
Make sure that the Device Option Tab is set properly before printing a document, or printing  
problems may occur.

URL Title
Enter an applicable URL title.

URL
Enter the URL address to be associated to the 

  button of the Paper Tab. 
(See page 69)

Contact
Enter applicable contact information
(i.e.: The email address of the contact person)

Auto Configuration

Edit URL...

Support Contacts (W)...

Support Contacts (W)...
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Changes the printer settings. Display the printer settings dialog box by performing the steps below.

NOTE 1. In Windows 2000/Windows XP/Windows Server 2003, setting of the properties depends on the 
logon accounts. This section describes properties to be specified by a user, upon executing a 
print operation in an application. See "Configuring the Printer Driver Settings (Administrator)" 
for details on administrator (system manager) properties. (See page 58)

Windows 2000/Windows XP/Windows Server 2003 (User)

1 Select Print in the File menu of the application.

2 Select the printer model in the name list box.

3 Click the  button in the Print dialog box. 

4 The printer properties dialog box appears. Click the
desired tabs of the dialog box and specify the properties.
(See Note 1)
(See pages 68 - 73)

Properties...
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Paper Tab

1. Paper Size
Select a document size.

2. Copies (1-999)
Specify the number of copies to be printed.  If the number of copies to be printed can be specified within 
the application, indicate one copy here and specify the number of copies in the Print dialog box of the 
application.

3. Orientation
Specifies how the document is positioned on the page. Portrait orients the print vertically. Landscape 
orients the print horizontally.

4. Output Size
Specifies the paper size to use. The various paper sizes listed match those supported by your printer. 

5. Zoom (50-200)
Specify an enlargement or reduction percentage when printing documents.  If enlargement/reduction can 
be set within the application, indicate 100% here and specify the enlargement/reduction percentage in 
the Print dialog box of the application.

6. Paper Type
Select the Paper Type you want to use.

7. Paper Source
Specify where the paper you want to use is located in the device.  If you choose Auto Tray Selection, 
the printer driver will automatically select an appropriate tray according to the Paper Size selected.
If the matching paper size is not found, the printer driver will select the Tray 1.

8. Print Properties Status Icons
Show the print status for the following properties.
• Paper Style (Output Tab)
• N in 1 (Output Tab)
• Sort (Output Tab)

9. Status Monitor
Recalls Network Status Monitor. (See page 187)

All Windows Common Settings
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10.  button
Open the Support window. The URL address(es) will be displayed if they were entered in the Device
Options Tab. Click the  button to open the Web page.

Support Contacts (W)...
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All Windows Common Settings

 Output Tab

1. Paper Style
Select duplex printing for printing on both sides of the paper.
You can select the printing style among 1-Side/2-Sided (Long Edge) /2-Sided (Long Edge Margin) /2-
Sided (Short Edge) /2-Sided (Short Edge Margin).

• Binding Position
Select the binding side (Long Edge/Short Edge) for duplex printing.

• Binding Margin
Select the binding margin upon duplex printing.

2. N in 1
Specify the layout pattern for printing multiple documents on a single sheet of paper. 

3. Sort
Select whether to Stack or Sort when printing multiple copies.

Note: Sort settings made on the printer driver screen have priority.
It is not  recommended to make them on the application screen. 
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4.  Button

• Print All Text as Black (Windows 98/Windows Me only).
All colored text is printed as solid black

• Print Blank Pages
Select whether the blank pages are printed.

• Copies
When printing a large amount of data with sort mode, the machine might not be able to print
due to lack of memory capacity.

In this case, select Printer Driver Controlled, as sorting is processed by the printer driver. However,
this mode may take more time to print.

Advanced...
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All Windows Common Settings

Quality Tab

1. Halftone (For Windows 98/Windows Me only)
Select either None or Dither.

2. Resolution
Select the print resolution (300 dpi / 600 dpi). (See Note 1) 

3. Contrast
Adjust the contrast of print images. (Note: Only if Halftone is set to None.)

4.  button (For Windows NT/Windows 2000/Windows XP/Windows Server 2003 only)

• Contrast
Adjust the contrast of print images.

• Brightness
Adjust the brightness of print images.

• Dark Picture
Select this option in order to print dark images brighter.

• Negative
Select this option in order to print images with black and white reversed.

• Input RGB Gamma
Adjust the gamma of print images (color intensities). Red, Green and Blue can also be adjusted 
individually.

• Black Ref/White Ref
Adjust the difference between the darkest and lightest colors of an image. Increasing the Black Ref 
value or decreasing the White Ref value will intensify the contrast of the image but reduces the range of 
colors in between.

• Picture
Select a test pattern type.
Selecting the View check box will display halftone adjustment results in the test pattern.

NOTE 1. dpi (dots per inch) represents the number of dots contained in one inch.  The larger the value,
the higher the resolution would be.

<Windows 98/Windows Me> <Windows NT/Windows 2000/
  Windows XP/Windows Server 2003>

Halftone Color Adjustment...
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Secure Tab

1. Mailbox (Available if the optional Hard Disk Drive Unit (DA-HD19) or an SD Memory Card (256MB 
or 512MB) is installed.)
Check this checkbox and enter the User ID (up to 8 digits) when storing the print data into the mailbox of 
the machine. 

Note: Turning the Power Switch OFF while a print file is being stored (DATA indicator lamp flashing) into 
the Mailbox may cause all files in it to be lost.

2. Secure Mailbox (Available if the optional Hard Disk Drive Unit (DA-HD19) or an SD Memory Card 
(256MB or 512MB) is installed.)
Check this checkbox and enter the User ID (up to 8 digits) and the password (4 digits) when storing the 
print data into the secure mailbox of the machine. 

Note: Turning the Power Switch OFF while a print file is being stored (DATA indicator lamp flashing) into 
the Secure Mailbox may cause all files in it to be lost.

3. Dept. Counter Mode On
Check this checkbox and enter the department code if your administrator requires departmental codes in 
order to print a file.
73
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Print Operation

If the printer driver is installed properly and a printer is selected as the default printer (see Note 1) in the
printer setup, printing can be accomplished from any Windows application with simple operations.

To print from most Windows applications, use the Print... command in the File menu. Selecting the Print...
command typically displays the following Print dialog box:

After selecting the print range to be printed and the number of copies, click the  button to start
printing.

While documents are being printed, a printer icon appears in the System Tray near the clock in the bottom
right hand corner of the screen. The icon disappears when printing is completed.

You may double-click on the printer indicator in the system tray to open and verify the details of the print
queue in the spooler.

NOTE 1. Follow the steps below to set a default printer:
1) Click the Start button and select Printers in the Settings menu.
2) Select the printer icon in the window and select [Set as Default] in popup menu by right-

clicking it. Then the check mark is displayed.

Printing from Windows Applications

OK
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When sharing a printer by connecting two computers via a crossover cable or using a hub, a connection
among computers must be established. (See Note 1 and 2)

Establishing a connection among computers can be verified by displaying the connected computers in
Network Neighborhood on the desktop.

The settings for printer sharing are specified by performing the following steps.

Printer server (PC connected to a printer)

Upon completing this setting, the shape of the icon changes indicating that the printer is shared.

NOTE 1. Refer to the manual for the network card and Windows user's guide for connections among
computers.

2. On Windows 98/Windows Me, a computer connected to a printer must be set up to allow
printer sharing by performing the following operations:
a) Double-click on Network in control panel, and then click  button

in the Configuration tab.
b) Check [I want to be able to allow others to print to my printer(s).] in the File and Print

Sharing dialog box.

Printing on Network

1 Install the printer driver on the computer to be connected 
to the machine.

2 Click the Start button, select Settings, and then click 
Printers.

3 Right-click on the desired printer icon and select 
[Sharing...] in the popup menu.

4 Select Shared As in the properties dialog box.

5 Click the  button.OK

File and Print Sharing...
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Printing on Network

Remote (PC that uses another computer's printer)

The operations above enables the output from the remote computer to a printer connected to the printer 
server.

1 Click the Start button, select Settings, and then click 
Printers.

2 Double-click Add Printer in the printers folder window.
The Add Printer Wizard appears.

3 Select Network Printer.
Click the  button.

4 Specify the other computer's printer by entering the 
network path.

Then, complete the installation following the instructions 
of the Add Printer Wizard.

Next
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Mailbox and Secure Mailbox

Your machine has mailboxes that enable you to store print file(s) into them with a User ID (UF-7000/7100/
8000/8100 up to 10 users or UF-9000 up to 100 users). To secure the file, a Password is required when 
printing the file (Secure Mailbox). Available if the optional Hard Disk Unit (DA-HD19 for UF-9000) or an SD 
Memory Card (256MB or 512MB for UF-7000/7100/8000/8100) is installed.

To configure the mailbox or secure mailbox to accept print file storage, see page 73.

Note: 1. Turning the Power Switch OFF while a print file is being stored (DATA indicator lamp is flashing) 
into the Mailbox or Secure Mailbox may cause all files to be lost.

2. When using the Mailbox or Secure Mailbox feature, there is a limitation of 20 mailboxes per User 
ID. If more than 20 print jobs are sent to an User ID, jobs will be deleted from the memory. Jobs 
will also be deleted if the optional Hard Disk Unit or SD Memory Card is full.

General Description
77
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Follow the procedure below to print a file from a Mailbox on your machine.

Printing a File from the Mailbox

1 Print a file to the Mailbox (up to 20 mailboxes for each User 
ID) with the User ID (see page 73).

2 PRINTER ON LINE

3
    

ENTER USER ID
❚

4 Enter the User ID (up to 8 digits) from the keypad (i.e. 
12345678)

ENTER USER ID
12345678

5 USE ∨ OR ∧ TO SCROLL
        TOTAL DOC=nn

6  or  repeatedly until the display shows the file you want 
to print.

(Panasonic)  10:11
(Pana.doc)

7 1:PRINT  2:ALL PRINT
3:DELETE 4:ALL DEL.

8  to print the displayed file.

 to print all files for the User ID.

* PRINTING *
PC DATA

9 Your machine will print the file. The file is automatically deleted 
after printing. PRINTER ON LINE

UF-9000 UF-7000/7100/8000/8100

Sample display

Name of the file owner
(Up to 10 characters)

Received time

File name 
(Up to 10 characters)

Number of copies to be printed

Number of pages

Job time

1

2
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Follow the procedure below to delete a file on the Mailbox.

Deleting a File from the Mailbox

1 PRINTER ON LINE

2
    

ENTER USER ID
❚

3 Enter the User ID (up to 8 digits) from the keypad (i.e. 
12345678)

ENTER USER ID
12345678

4 USE ∨ OR ∧ TO SCROLL
        TOTAL DOC=nn

5  or  repeatedly until the display shows the file you want 
to delete.

(Panasonic)  10:11
(Pana.doc)

6 1:PRINT  2:ALL PRINT
3:DELETE 4:ALL DEL.

7  to delete the displayed file.

 to delete all files for the User ID.

DELETE DOCUMENT?
1:YES 2:NO

8
  

PRINTER ON LINE

UF-9000 UF-7000/7100/8000/8100

3

4

79
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Follow the procedure below to print a file from a Secure Mailbox on your machine.

Printing a File from the Secure Mailbox

1 Print a file to the Secure Mailbox (up to 20 mailboxes for each 
User ID) with the User ID and a Password (see page 73).

2 PRINTER ON LINE

3
    

ENTER USER ID
❚

4 Enter the User ID (up to 8 digits) from the keypad (i.e. 
12345678)

ENTER USER ID
12345678

5 USE ∨ OR ∧ TO SCROLL
        TOTAL DOC=nn

6  or  repeatedly until the display shows the file you want 
to print.

(Panasonic)  10:11
(Pana.doc)

7 ENTER PASSWORD
❚

8 Enter the Password (4 digits) from the keypad (i.e. 1234) ENTER PASSWORD
****

9 SECURE MAILBOX
1:PRINT 2:DELETE

10  

* PRINTING *
PC DATA

11 Your machine will print the file. The file is automatically deleted 
after printing. PRINTER ON LINE

UF-9000 UF-7000/7100/8000/8100
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Follow the procedure below to delete a file from a Secure Mailbox on your machine.

Deleting a File from the Secure Mailbox

1 PRINTER ON LINE

2
    

ENTER USER ID
❚

3 Enter the User ID (up to 8 digits) from the keypad (i.e. 
12345678)

ENTER USER ID
12345678

4 USE ∨ OR ∧ TO SCROLL
        TOTAL DOC=nn

5  or  repeatedly until the display shows the file you want 
to delete.

(Panasonic)  10:11
(WORKiO.doc)

6 ENTER PASSWORD
❚

7 Enter the Password (4 digits) from the keypad (i.e. 1234) ENTER PASSWORD
****

8 SECURE MAILBOX
1:PRINT 2:DELETE

9   

DELETE DOCUMENT?
1:YES 2:NO

10
  

PRINTER ON LINE

UF-9000 UF-7000/7100/8000/8100
81
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Setting Your Machine

When your machine is used as a Network Printer, the following parameters should be set properly in 
advance.

• IP Address
• Subnet Mask
• Default Gateway IP Address

� UF-7000/7100/8000/8100

If your network has already been setup with DHCP service, set the Fax Parameter No. 169 (DHCP CLIENT)
to Valid so that the parameters are set automatically. (For details, see the Operating Instructions for
Facsimile and Copy Functions)

Follow the procedures below if you need to set the parameters manually.

Network Parameters

1 Make sure that the  ,  and 

 lamp is OFF.

2
  

SET MODE       (1-9)
ENTER NO. OR ∨ ∧

3 1:USER PARAMETER?
PRESS SET TO SELECT

4  repeatedly until the display shows;

IP ADDRESS
❚

5 Enter the IP Address. Use the  key to enter a 
period.

IP ADDRESS
133.178.240.3❚

6 SUBNET MSK
❚

7 Enter the Subnet Mask. Use the  key to enter a period. SUBNET MSK
255.255.255.0❚

8 DEF. GATEWAY IP ADDR
❚

9 Enter the Default Gateway IP Address. Use the  key 
to enter a period.

DEF. GATEWAY IP ADDR
133.178.240.0❚

10
 

PRINT SCAN/FILE

EMAIL
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� UF-9000

If your network has already been setup with DHCP service, set the General Settings for Key Operator No. 
22 (DHCP CLIENT) to Valid so that the parameters are set automatically. (For details, see the Operating 
Instructions for Facsimile and Copy Functions)

Follow the procedures below if you need to set the parameters manually.

1 Make sure that the  lamp is ON.

2
  

GENERAL PARAM. (1-9)
ENTER NO. ❚ OR ∨ ∧

3 09 KEY OPERATOR MODE
ENTER PASSWORD=❚❚❚

4 Enter the Key Operator Password. 09 KEY OPERATOR MODE
ENTER PASSWORD=***

5 KEY OPR.MODE (00-31)
ENTER NO. ❚ OR ∨ ∧

6  

19 TCP/IP ADDRESS
❚

7 Enter the IP Address. Use the  key to enter a 
period.

19 TCP/IP ADDRESS
133.178.240.3❚

8 20 TCP/IP SUBNET MSK
❚

9 Enter the Subnet Mask. Use the  key to enter a period. 20 TCP/IP SUBNET MSK
255.255.255.0❚

10 21 TCP/IP G/W ADDR.
❚

11 Enter the Default Gateway IP Address. Use the  key 
to enter a period.

21 TCP/IP G/W ADDR.
133.178.240.0❚

12
 

COPY
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Make sure that the  lamp is ON. 

Press ,  and  to set the Printer Settings.

*1 Available only when the optional Printer Controller Module is installed.
*2 Available only when the optional Hard Disk Drive Unit or an SD Memory Card is installed.

Printer Settings

No. Modes Function Initial Setting
00 NUMBER OF PRINTS Sets the initial number of prints

1-999
1

01 PAPER SIZE Sets the paper size setting.
LETTER / INVOICE / FLS1 / FLS2 / A4 / B5 / A5 /
LEGAL

--

02 PAPER TRAY Sets the default Paper Tray setting.
AUTO / BYPASS / TRAY-1 / TRAY-2 (Option)

AUTO

03 PRINT DIRECTION Sets the default print direction setting.
1:PORTRAIT / 2:L-SCAPE

PORTRAIT

04 PRINT DATA Determines the provision of the print data.
PRESS SET TO PRINT

05 2-SIDED PRINT Selects whether the 2-Sided print setting is enabled.
1:OFF / 2:ON

OFF

06 BIND POSITION Sets the bind position.
1:LONG EDGE / 2:SHORT EDGE

LONG EDGE

07 RESOLUTION Sets the resolution setting.
1:300dpi / 2:600dpi / 3:1200dpi

600dpi

08 FONT (PCL)*1 Sets the PCL font.
0-99

0

09 SYMBOL TABLE (PCL)*1 Sets the PCL symbol table.
0-35

11

10 PITCH (PCL)*1 Sets the PCL pitch.
0.44-99.99

10.00

11 POINT SIZE (PCL)*1 Sets the PCL point size.
4.00-999.75

12.00

12 LINES/PAGE (PCL)*1 Sets the PCL lines/page.
5-128

60

13 RETURN CHARACTER (PCL)*1 Sets the PCL return character.
1:CR / 2:CR+LF

1:CR

14 MUTUAL A4/LETTER Selects whether the mutual size A4/LETTER is 
enabled.
1:OFF / 2:ON

1:OFF

15 MAILBOX MEMORY STATUS*2 Indicates the mailbox memory status.

19 KEY OPERATOR MODE Inputs the key operator password.
ENTER PASSWORD =���

PRINT

FUNCTION 4 SET
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The following Parameter Settings require to input the Key Operator Password.

*1 Available only when the optional Multi Page Description Language Controller Module is installed. 
(UF-9000 only)

*2 Available only when the optional Printer Controller Module is installed.
*3 Available only when the optional Hard Disk Drive Unit or an SD Memory Card is installed.
*4 Available only when the optional Hard Disk Drive unit is installed. (UF-9000 only)

No. Modes Function Initial Setting
00 PRINTER SETTINGS Prints the printer settings.

PRESS SET TO PRINT

01 COMPLETION TIME Sets the job completion time.
1-999SEC (seconds)

180SEC

02 PAGE PROTECTION Selects whether to enable automatic compression
when the received data exceeds the page memory
capacity.
(This is accomplished by reducing resolution, and/or
deleting pixels to fit the data onto the available page
memory, then print it out.)
When the setting is in the "OFF" position, upon
exceeding the page memory capacity, the print job
is deleted and an Error message is displayed.
1:OFF / 2:ON

1:OFF

03 ERROR PAGE PRINT Selects whether to print the error page.
1:OFF / 2:ON

2:ON

04 SPOOL FUNCTION *4 Selects whether to enable the spool function.
1:OFF / 2:ON

2:ON

05 TEXT PRINT Selects whether to print the text page only.
1:OFF / 2:ON

2:ON

06 PS CONFIGURATION*1 Prints the PS configuration page.
PRESS SET TO PRINT

07 FONT LIST PRINT (PCL)*2 Sets the PS printing font list.
PRESS SET TO PRINT

08 FONT LIST PRINT (PS)*1 Sets the font list print of PS.
PRESS SET TO PRINT

09 MAILBOX DATA HOLD*3 Selects the automatic holding time frame for the
mailbox data.
Infinity / 1 DAY / 2 DAYS / 3 DAYS / 4 DAYS 
5 DAYS / 6 DAYS / 7 DAYS

7 DAYS

10 DELETE MAILBOX*3 Selects whether to delete the mailbox data.
1:ALL / 2:BEFORE

2:BEFORE

12 APPLETALK ZONE*1 Inputs a AppleTalk zone name.
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Specification

*1: For UF-7100/8100 only

Available Paper Type and Paper Size

Paper Type Paper Size Print from
Paper Tray

Print from
Sheet Bypass

Print from 2nd 
Paper Tray 
(Optional)

Print by
2-Sided Print 

Mode

Plain Paper Letter Yes Yes Yes Yes

Legal Yes Yes Yes Yes

Invoice No Yes No No

FLS1 No Yes No No

FLS2 No Yes No No

A4 Yes Yes Yes Yes

B5 Yes *1 Yes Yes *1 Yes *1

A5 Yes *1 Yes No No

Thick Paper Letter No Yes No No

Legal No Yes No No

Invoice No Yes No No

FLS1 No Yes No No

FLS2 No Yes No No

A4 No Yes No No

B5 No Yes No No

A5 No Yes No No

Cotton Paper Letter Yes Yes No No

Legal Yes Yes No No

Invoice No Yes No No

FLS1 No Yes No No

FLS2 No Yes No No

A4 Yes Yes No No

B5 Yes *1 Yes No No

A5 Yes *1 Yes No No

Transparency Letter Yes Yes No No

A4 Yes Yes No No

Label Letter No Yes No No

A4 No Yes No No

Envelope #9 No Yes No No

#10 No Yes No No

Monarch No Yes No No

DL No Yes No No

C5 No Yes No No
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Available Paper Weight and Capacity

Paper Type Print from
Paper Tray

Print from
Sheet Bypass

Print from 2nd 
Paper Tray 
(Optional)

Paper Weights Plain Paper 16 – 28 lb
(60 – 105 g/m2)

16 – 28 lb
(60 – 105 g/m2)

16 – 28 lb
(60 – 105 g/m2)

Thick Paper No 29 –  44 lb
(106 – 165 g/m2)

No

Envelope No 24 lb (90 g/m2) No

Paper Capacity Plain Paper 
20 lb (75 g/m2)

250 sheets 1 sheet 550 sheets

Transparency 20 sheets 1 sheet No

Label No 1 sheet No

Envelope No 1 sheet No
87
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You may also print on high quality labels and transparencies that are made specifically for Laser printers. 
We recommend using the following types.

• To avoid damaging the printer, do not use transparencies made for Inkjet printers.
• Do not use transparencies that have already been fed through the printer once.

Note: The labels must completely cover the backing material as shown below.

Transparencies and Labels

Paper Type Paper Size Recommended Type

Transparency Letter/A4 3M CG3300

Label Letter Avery 5160 – 5163, Avery 5660 – 5663

A4 Avery L7159 –L7164

NOYES

Labels cover the entire
backing material

The backing material is exposed.
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It is recommended that you purchase only high quality envelopes with diagonal seams as shown below.

High quality envelopes have the following characteristics:
• A thin, sharply creased leading edge.
• Paper weight of 24 lb (90 g/m2).
• Flat, free of curls, wrinkles, nicks, etc.

It is not recommended that you use envelopes with any of the following characteristics (using these may
result in paper jams).
• Irregularly shaped envelopes
• Envelopes with curls, wrinkles, nicks, twists, dog-ears or other damage
• Envelopes with side seam construction
• Highly textured envelopes, or with extremely shiny surfaces
• Envelopes that seal by removing a peel-off strip
• Envelopes with more than one flap to be sealed
• Self-adhesive envelopes
• Envelopes that are baggy or not sharply creased
• Embossed envelopes
• Envelopes that have previously been printed with a laser printer
• Envelopes that have been previously printed inside

Envelopes

Side seam
construction Peel-off strip Multiple flaps

TwistCurl Bent-edgeWaveDog-ears

Self adhesive
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Envelopes

Do not attempt to print on any of the following types of envelopes. These may cause damage to your printer.
• Envelopes with clasps, snaps or tie strings (see Figure 1)
• Envelopes with transparent windows (see Figure 2)
• Envelopes that will melt, discolor, scorch, offset or release hazardous emissions when exposed to 200 

°C (392 °F) for 0.1 second
• Envelopes that use encapsulated types of adhesive that do not require moistening but rely on pressure 

to seal them

Always test a sample of the envelopes you are thinking of buying. Confirm that the envelope performs
acceptably.

For best printing results
• Avoid printing in high humidity.

High humidity may cause the envelope to curl and pick up excess toner.
High humidity may also cause the envelope to seal.

• Envelope storage is very important. Store them away from moisture and humid air, where they can lay 
flat and their edges will not be bent or damaged. The humidity should not exceed 70%RH.

Figure 1 Figure 2
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Sheet Bypass only

Loading the Envelopes

Printing side up

Flap

(International C5-
 opening on the shorter edge)

Printing side up

Flap
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Printer Specifications

Printing Speed <UF-7000/7100>
15 sheets/minute
(Letter size plain paper, simplex printing)
14 sheets/minute
(A4 size plain paper, simplex printing)

<UF-8000/8100/9000>
19 sheets/minute
(Letter size plain paper, simplex printing)
18 sheets/minute
(A4 size plain paper, simplex printing)

Resolution (dots per inch) 300 x 300, 600 x 600

Interface USB 1.1
Ethernet (10Base-T/100Base-TX)

Applicable OS Windows 98, Windows Me, Windows NT 4.0 (With Service Pack 
3 or later is required), Windows 2000, Windows XP, Windows 
Server 2003

Printer Working Memory 20 MB
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Document Management System Section

Installing the Document Management System

1 Insert the Panasonic Document Management 
System CD-ROM. (See Note 1 on page 97)

2 Select the language.

Note: If the CD-ROM does not launch 
automatically, double click the My 
Computer icon on the Desktop or on the 
Start menu, then double click the CD-
ROM icon. 

3 Click the  button.

4 Click Panasonic-DMS.

5 Click Install Panasonic-DMS Software.

Next
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6 Click Typical.

Note: (For UF-7000/7100/8000/8100 users)
The Panafax Desktop is not installed with 
the Typical Installation selection. If you 
wish to install it, choose Custom 
Installation and check the Panafax 
Desktop selection box.

7 Verify the installation destination and click the 

 button.

8 Verify the data folder destination and click the

 button.

9 (When the Panafax Desktop is installed)
Select Network Connected Model and click

the  button.

Next

Next

Next
95Continued on the next page...
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10 Select General User and click the  
button.

Note: If selecting Administrator, the network 
configuration editor and network address 
book editor will also be installed on your 
PC.  (See page 198)

11 Select Start with Windows and click the 

 button if you want to register the 

Panasonic Communications Utility to start with 
Windows.

12 Select Document Viewer and click the 

 button if you want to set the 

Document Viewer as the default application to 
view TIFF files.

13 <Windows XP Service Pack 2>
Select Enable 
Communications[Recommend] and click the 

 button.

Next

Next

Next

Next
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The Panasonic Document Management System folder has been added to the Program menu, and the
installation has now completed.

NOTE 1. When installing on Windows NT 4.0, Windows 2000, Windows XP or Windows Server 2003, 
logon to the computer using an account with administrator rights.

14 Enter the program folder name and click the 

 button.

15 The required files are copied.

16 When the setup process is completed, a 
message is displayed prompting you to restart 
your computer.

Click the  button to restart your 

computer.

When installing Panafax Desktop on Windows 
98/Windows NT, after rebooting your PC, the 
Microsoft Data Access Components are 
automatically installed. Install it in accordance 
with the directions of the screen.

Next

Finish
97
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Document Manager

Document Manager is an application for managing documents (image files). By utilizing the Document 
Manager and Document Viewer (see page 118) in combination, a number of documents (image files) can be 
classified, managed, browsed, and edited.

Selecting Panasonic → Panasonic Document Management System → Document Manager from 
Programs on the Start menu displays the main window of the Document Manager.

1.Title Bar
Displays the title of the screen.

2.Menu Bar
Displays the menus of the Document Manager.

3.Tool Bar
Displays tool buttons of the Document Manager. Tool buttons correspond to functions of the menus in the 
menu bar.

4.Folder Window
Displays the folders containing the documents in tree form.

5.Link Icon
Dropping a dragged document onto a link icon will activate the application corresponding to the function 
of the icon.

6.Status Bar
Displays information such as the number of documents in a folder, the number of selected documents, file 
sizes, etc.

Main Window
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7.Document Window
Displays a list of documents in the selected folder.
Documents are displayed in thumbnails (reduced images). Page number and  and  buttons are 
displayed at the bottom of a thumbnail image for grouped documents (configured with two or more 
pages).

•Image data files
A thumbnail image of the document is displayed.

•Application data files
A thumbnail image of the document with its original application icon is displayed (i.e. Word, Excel and 
PowerPoint).

Clicking the  and  buttons turns the page on a multi-page document.
99
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The Document Manager allows editing and managing documents displayed in thumbnail images by 
dragging and dropping. The function enables various operations as described below:

Basic Operations

• Selecting Documents
Clicking thumbnail images in the document window allows 
selection of documents. Dragging a mouse pointer on the 
screen or clicking with the Shift key held down allows 
selecting two or more documents at one time.

• Editing Documents
Double-clicking thumbnail images in the document window 
activates the Document Viewer. In addition, see page 118 for 
details on opening and editing documents.

• Creating Documents
Drag-and-drop any application file into the Document 
Manager to create a new document. A thumbnail image file is 
created and the application icon is displayed.
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• Copying/Moving Documents
Dragging a thumbnail image from the document window and 
dropping it onto a folder in the folder window moves the 
document to the folder. Drag-and-drop with the Ctrl key held 
down to copy a document.

Dragging a document and dropping it onto another document 
in a document folder results in grouping the two documents 
together.

Dragging a document and dropping it on a link icon activates 
an application corresponding to the function of each icon.
Link icons are registered and deleted by selecting Launch 
To Another Application → External Application Setup 
from the File menu.

• Dragging a document and dropping it onto “Shared Folder” 
allows other computers connected to the same network to 
access it.
Browse “Shared Folder” for how to create shared folders.
101
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• Import document (from file)
Selecting Open from the File menu displays a dialog box for selecting files. The dialog box allows 
importing image files saved in a computer as documents into the folder.

An attempt to import files that cannot be handled by Document Manager results in displaying an error 
shown below. Press OK and verify the file format.

Dragging and dropping a selected document onto a link icon at the bottom of the window activates an 
application specified for the link icon, and opens the image file.

The link icons can be Added/Removed by selecting Launch To Another Application → External 
Application Setup in the File menu.

The following applications can be specified as destinations of the Document Manager:

- Draw/Graphics software (applications such as MS-Paint, Photoshop etc.)
- OCR software (application such as e-Typist, etc.)
- PC-FAX/Printer
- E-Mail software (MAPI-compatible mail application such as MS-Outlook, Netscape Messenger etc.)
- Others

(Other application software that enables to import an image file.)

NOTE 1. Document Viewer provides a function to add various graphics and text to an image.
The graphics and text added to an image are called "Annotation." See "Annotation Menu" on
page 132 for additional details.

Setting Plug-in
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File Menu

• New Folder
Create a new folder under the folder that is currently selected. 
Path of a folder to be created can be specified as required.

• Shared Folder
Create a new shared folder. Documents in the shared folder 
can be shared through the network from different computers.

Note: Set a different folder path for each shared folder if 
multiple shared folders are created on your PC.

• Released Shared Folder
Release the shared folder. Documents in the shared folder 
will be released from a network.

• Open
A file saved in the computer can be imported into the folder as 
a document.

• Save As
A document is saved as an ordinary image file under a 
specified name.

• Rename
Change the name of a document.
103
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File Menu

• Properties

Displays the file properties.

• Backup
Creates a back up of the documents stored in the selected 
folder.

• Acquire Image
• Select Source

These menus are not available for the UF-7000/7100/8000/
8100/9000.

• Print
Prints the document selected in the document window.
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NOTE 1. Print Setup specifies printing or not printing annotations edited in the Document Viewer. See
"Annotation Menu" on page 132 for additional details.

• Print Setup (See Note 1)
Specify layout and printing size for a document to be printed.

1. Horizontal Position and Vertical Position
Adjust the printing position on the sheet.

2. Print Size
Select printing in original size or printing in accordance 
with the sheet size.

3. N in 1
Select for printing reduced pages on one sheet.

4. Multiple File Print
Select whether to merge the files when printing if multiple 
files are selected on the Document Manager.

5. Print Annotation
Select to print with annotations.

6. Print Label
Select to print with labels.

7. Print Page Frame
Select to print with page frame.

8. Print Page Number
Select to print with page number.

9. Page Number Format.
Set the page number format. 

10.Rotate To Match Page Size
Select to rotate to match with the page size.
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File Menu
NOTE 1. See "Setting Plug-in"  (page 102) to specify an external application.

• Launch To Another Application
Opens the document selected in the document window with a
specified application.

Selecting External Application Setup displays a dialog box for
adding/changing/deleting applications. (See Note 1)

Clicking the Add button displays the Add External Application
dialog box.

1. Name
If an external application is specified, the name in this field
appears on the link icon.

2. Application Type
Specify the application type.

3. Program File
Specify the execution file and the path of the application.

4. MAPI Compliant
Check here if the e-mail application is compatible with MAPI.

5. Printer
Specify the printer driver if selecting PC-FAX/Printer on the
Application Type.
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Click the  button to set the detail parameters when 
launching with an application.

1. Annotation
Select Paste when launching with annotations.
Select Paste Label if launching with Label Annotation.

2. File Format
Set the file format when launching with an application.

3. Compression
Set the compression mode when launching with an 
application.

4. Image Quality
Adjust the image quality when the JPEG file format is 
selected.

5. Image Type
Set the image type.

6. Halftone
Set the halftone mode when the Internet Fax TIFF file format 
is selected.

7. Resolution
Set the data resolution when launching with an application.

8. Paper Size
Set the paper size when the Internet Fax TIFF file format is 
selected.

9. Correct
Select Eliminate Noise or Correct Skew.

10.Original Document
Select whether to update the attached original file if the file is 
edited within the application, 

11.Parameter
Set the parameter when opening an application.

12.Transmission Check Message
Select whether to show a verification message when sending 
a data to the application.

13.When Opening "xx" Number of Windows
Set the number of application windows to open. If the file 
requires a number of the application windows to open, a 
verification message is displayed before the file is opened.

Open Details
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File Menu

• Trash Can

- Open Trash Can
Opens the Trash Can and displays files in it. Selecting 

documents and clicking the  button restores 
documents that have been discarded.

Note: Ensure that your PC has access to the Shared 
Directory before restoring the files onto the shared 

folder by using the  button, otherwise, 
the files will be restored into the Network Scanner 
Image folder.

Click the  button to delete the selected 
document.

- Empty Trash Can
Deletes the files in the Trash Can. If the documents are 
emptied from the Trash Can, they are permanently deleted. 
They are Not stored in the Recycle Bin.

Undo

Undo

Delete
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• Environment Setup
- Thumbnail

Set the thumbnail size on the Document Manager.

- Application File
Set the thumbnail image creation course of action when 
importing a file.

- Dropout
Set the file format when moving/copying the file on the 
Document Manager to another directory.
1. Use same format as Document Manager.

The file is saved in the same format (PNG, BMP, TIFF, 
JPG).

2. File Format/Compression Format/Annotation.
Select the file format and select whether the annotations 
are saved.

3. Save the attached file
Set to save the attached file.
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Edit Menu
• Undo

Undoes the operation edited lastly.

• Cut
Deletes a selected document from a folder and copy it to the 
clipboard.

• Copy
Copies a selected document to the clipboard.

• Paste
Pastes a document from the clipboard into the selected folder.

• Delete
Deletes a selected document from a folder to the Trash Can.
A confirmation message for deletion appears.

• Select All
Selects all documents in the folder.

• Find
Searches for documents by specifying a document name, 
creation date, character string or DD Code in the document.

Note: The DD Code Tab is available when the Options Menu 
is set to enable the DD Function (see page 114). 
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View Menu
• Tool Bar

Switches between displaying/hiding the tool bar.

• Status Bar
Switches between displaying/hiding the status bar.

• List Format/Thumbnail Format
Switches between list display and thumbnail display in the
document window.

• Show Annotation
Switches between displaying and hiding annotation.

• Arrange Folders
Sorts the document folders by name or date.

• Arrange Document
Sorts the documents in the current folder in the specified
order (Name, Type, Size or Date).

- Auto Arrange
Lines up the Documents automatically in Thumbnail Format.

- Line Up Documents 
Line up the documents in the document window.

• Refresh
Refreshes the contents of the Document  Manager.
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Document Menu
• Open

Opens a selected document, activates the Document Viewer 
(see page 118), and opens the document for editing.

• Duplicate
Makes a copy of the selected document in the folder.

• Rotate
Rotates the selected document.
- Rotate Left
- Rotate 180 Degrees
- Rotate Right

• Group
Makes a group of two or more selected documents. The 

grouped documents are indicated by page number and  

and  buttons at the bottom of a thumbnail image.

- Every Document
The selected documents are grouped.

- Every Page Alternately
Groups pages alternately.

- Every Page Reverse Alternately
Groups pages alternately by reversing the pages.
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• Ungroup
Cancels the grouping for grouped documents. Either dividing 
all pages into individual documents or releasing only specified 
documents from a group can be selected.

• Enhancement
Applies the following correction to a selected document:

- Correct Skew
Detects any inclination of the document and automatically 
correct it.

- Enhance Edge
Enhances edges (borders) of images.

- Eliminate Noise
Removes noise on the document.

- Reverse Gradation
Displays images in reverse.

• Page
Selects pages to be displayed in thumbnail among grouped 
documents.

Selecting Rearrange Page displays the Rearrange Pages dialog 
box. The order of the pages are changed by selecting, dragging 
and dropping the pages.
Click the Reverse Order button to reverse the page order.

• Attached File
Opens a dialog box to launch the application associated with 
the selected attachment.

• File Conversion
Creates an image of the selected attachment.
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Note: The Options Menu is not available for the UF-7000/7100/8000/8100/9000.

Options Menu

• Setup
Selects the expansion feature(s) available for the Document 
Manager.

To enable the expansion feature for DD Server Software, select 

DD Function and click the  button.

Select the data folder (DD Folder) on the server.

• [Options] - [DD Function] - [Print DD Cover]
Prints the DD Cover page selected in the document window
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Image Converter

Once Panasonic-DMS has been installed, the Panasonic Document Manager (Image Converter) is 
automatically installed in the Printers folder. This driver is for rasterizing application files such as from 
Microsoft® Word or Microsoft® Excel, and for placing them in the Document Manager. To change the default 
properties, follow the instructions below:

1. Click the Start button, select Settings, and then click Printers.

2. Right-click on Panasonic Document Manager and select Properties from the popup menu.
The Properties dialog box appears.

3. Click the  button to save the settings and close the Properties dialog box.

General Description

Windows 98/Windows Me

• Paper/Layout Tab

- Paper Size
Sets the document paper size.

- Orientation
Sets the document orientation.

- Resolution
Sets the document resolution.

• Quality Tab

- Color
Sets the document color conversion to color or 
monochrome.

- Monochrome
Select Normal (Black and White) or Grayscale (Photo) when 
converting to monochrome. Also sets the brightness and 
contrast. 

OK
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1. Click the Start button, select Settings, and then click Printers.

2. Right-click on Panasonic Document Manager and select Document Defaults from the popup menu.
The Document Properties dialog box appears.

3. Click the  button to return to the Printers folder.

Windows NT 4.0

• Page Setup Tab

- Paper Size
Sets the document paper size.

- Orientation
Sets the document orientation.

- Color Appearance
Sets the document to color or grayscale.

• Advanced Tab

- Paper Size
Sets the document paper size.

- Orientation
Sets the document orientation.

- Resolution
Sets the document resolution.

- Color Appearance
Sets the document to color or grayscale.

- Metafile Spooling

- Halftone Color Adjustment

OK



Image Converter

D
oc

um
en

t M
an

ag
em

en
t 

Sy
st

em
 S

ec
tio

n

1. Click the Start button, select Settings, and then click Printers.

2. Right-click on Panasonic Document Manager and select Printing Preferences from the pop-up menu.
The Printing Defaults dialog box appears.

3. Click the  button to return to the Printers folder.

Windows 2000/Windows XP/Windows Server 2003

• Layout Tab
Sets the document orientation.

• Paper/Quality Tab
Sets the document to color or grayscale.

• Advanced button
Sets the paper size, resolution, and spooling properties.

OK
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Document Viewer

The Document Viewer is an application for editing documents (image files) to be managed with the 
Document Manager (see page 98). In addition to usual image editing, the program provides various editing 
capabilities for documents with a wide selection of annotation functions.

Double-clicking on the document (thumbnail) in the Document Manager screen or selecting Open in the 
Document menu displays the main window of the Document Viewer. (See Note 1)

NOTE 1. The program can be also activated by selecting Panasonic → Panasonic Document 
Management System  → Document Viewer from Programs in the Start menu.

Main Window
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1. Title Bar
Displays the title of the screen and the name of the image file being displayed.

2. Menu Bar
Displays the menus of the Document Viewer.

3. Tool Bar
Displays tool buttons of the Document Viewer. Tool buttons correspond to functions of the menus in the
menu bar.

4. Page List
Displays the pages of the documents as thumbnails (reduced image).

5. Size Bar
Adjusts the scaling of the display on the image window.

6. Link Icon
Dragging and dropping a document on a link icon activates the application corresponding to each icon.

7. Status Bar
Displays information such as image file name, image type, and size.

8. Image Window
Displays the image and annotations of the pages being selected.

9. Ruler
Displays the actual size of an image that is selected. The unit of measurement can be switched by
Detailed Settings...→ Ruler in the View menu.
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Basic Operations
• Selecting Page

Selecting a page, by clicking it in the page list, displays an 
image of the selected page on the image window.

Dragging and dropping a page within the page list can change 
the order of the pages.

• Image Editing
The image displayed in the image window can be edited with 
the menu below:

- Edit menu 
Editing operations such as cutting, copying, pasting, and 
adding annotations.

- Page - Adjust Page menu 
Image correction and color balance adjustment of the whole 
page.

• Selecting Area
Dragging the mouse on the image window allows to select a 
specific area in an image. This function is used to save a 
specified area or to specify an area for annotation.
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Document Viewer provides functions to add various graphics and text to an image. The graphics and text 
added to an image are called <Annotation>.

The annotation function, unlike those in usual image editing applications, does not change the image itself 
but lays graphics and text on the image. Annotations and the original image are displayed as one image.

Annotations are managed separately from image data. Therefore, the Document Viewer can switch 
between displaying and hiding annotations.

If an image is edited with the Document Viewer, and is exported (sent) to another image editing application, 
it can be sent with/without the annotation to the image.

Annotation Function

Annotation Original image Annotation added
to the original image
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File Menu
• Open

Opens an image file saved in the computer.
Files of the following formats can be opened on the Document
Viewer.

- DDM
Document Manager file format.

- BMP 
Windows standard bitmap format.

- TIFF
Tagged Image File Format (TIFF).

- JPEG 
Joint Photographic Experts Group (JPEG) format.

- PNG
Portable Network Graphics format.

• Save (See Note 1 on page 123)
Saves a document being edited.

• Save As (See Note 1 on page 123)
A document is saved as an ordinary image file under a specified 
name.

- All Page(s)
Saves all pages in the document.

- Select Page
Saves only the selected page.

- Specified Area
Saves only the portion specified in the image window.

Document Viewer saves a file in the following formats:

- Multi-page TIFF
Multipages Tagged Image File Format (TIFF).

- TIFF
Tagged Image File Format (TIFF).

- BMP 
Windows standard bitmap format.

- Internet Fax TIFF
Tagged Image File Format (TIFF) with Internet Fax format.
Note: This format is available for monochrome image files 

only. When saving the file that is created by an 
application software  (i.e. Microsoft Word), select the 
Monochrome or Grayscale on the Image Converter 
in advance. (See pages 115 to 117) 

- JPEG 
Joint Photographic Experts Group (JPEG) format.

Note: This format is available only when either Grayscale or 
RGB file type is selected in the Page → Adjust Page 
menu.  (See page 129)

- PNG
Portable Network Graphics format.

- PDF
Adobe Portable Document Format (PDF).

- DDM
Document Manager file format.
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NOTE 1. When saving a document with annotations, save the document using the Document Manager
file format (DDM). This format saves the annotations and image data separately (as objects) so
that they can be edited later. Although saving a document using other formats allow further
editing, annotations cannot be made. They will be merged within the file.

• Print
Prints a document under the editing operation. For a document 
containing two or more pages, pages from-to can be specified 
for printing.

• Print Setup
Specifies the layout, printing size, and printing of annotations for 
a document to be printed.

1. Horizontal Position and Vertical Position
Adjusts the printing position on the sheet.

2. Print Size
Select printing in original size or printing in accordance with 
the sheet size.

3. N in 1 
Select for printing two or more reduced pages on one sheet.

4. Print Annotation
Select to print with annotations.

5. Print Label
Select to print with labels.

6. Print Page Frame
Select to print with page frame.

7. Rotate To Match Page Size
Select to rotate to match with the page size.
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File Menu

• Launch To Another Application

Opens the document selected in the document window with 
a specified application.

Selecting External Application Setup (see Note 1) displays a 
dialog box for adding/changing/deleting applications.

Clicking the Add button displays the Add External Application 
dialog box.

1. Name
If an external application is specified, the name in this field 
appears on the link icon.

2. Application Type
Specify the application type.

3. Program File
Specify the execution file and the path of the application.

4. MAPI Compliant
Check here if the e-mail application is compatible with 
MAPI.

5. Printer
Specify the printer driver if selecting PC-FAX/Printer on the 
Application Type.
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NOTE 1. See "Setting Plug-in"  (page 102) to specify an external application.

Click the  button to set the detail parameters when 
launching with an application.

1. Annotation
Select Paste when launching with annotations.
Select Paste Label if launching with Label Annotation.

2. File Format
Set the file format when launching with an application.

3. Compression
Set the compression mode when launching with an 
application.

4. Image Quality
Adjust the image quality when the JPEG file format is 
selected.

5. Image Type
Set the image type.

6. Halftone
Set the halftone mode when the Internet Fax TIFF file format 
is selected.

7. Resolution
Set the data resolution when launching with an application.

8. Paper Size
Set the paper size when the Internet Fax TIFF file format is 
selected.

9. Correct
Select Eliminate Noise or Correct Skew.

10.Original Document
Select whether to update the attached original file if the file is 
edited within the application, 

11.Parameter
Set the parameter when opening an application.

12.Transmission Check Message
Select whether to show a verification message when sending 
a data to the application.

13.When Opening "xx" Number of Windows
Set the number of application windows to open. If the file 
requires a number of the application windows to open, a 
verification message is displayed before the file is opened.

Open Details
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File Menu

• Trash Can

- Open Trash Can
Opens the Trash Can and displays any page in it. 

Selecting page and clicking the  button 
restores page that has been discarded.

Note: Once you exit the Document Viewer, the pages in 
the Trash Can are deleted.

- Empty Trash Can
Deletes the pages in the Trash Can. If a page is emptied 
from the Trash Can, it is permanently deleted. it is Not 
stored in the Recycle Bin.

Undo
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Edit Menu
• Undo

Undoes the last editing operation done.

• Cut
Deletes a selected annotation and copies it to the clipboard.

• Copy
Copies a selected annotation on the clipboard.

• Paste
Pastes an annotation from the clipboard into the selected 
page.

• Clear
Clears a selected annotation.

• Select All
Selects all annotations on the selected page.
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Page Menu
• Next

Displays the next page.

• Previous
Displays the previous page.

• Top
Displays the top page.

• Last
Displays the last page.

• Select
Displays a specified page.

• Auto Paging
Turns the pages automatically.
- Move Forward

Automatically steps through pages forwards.
- Move Backward

Automatically steps through pages backwards.
- Stop

Stops automatic paging.
- Setup 

Sets automatic paging.

• Move Page
Moves pages to the desired position.
- Next Page

Moves the current page to the next page.
- Previous Page

Moves the current page to the previous page.
- Top Page

Moves the current page to be the top page.
- Last Page

Moves the current page to be the last page.
- Select Page

Moves the current page to the page you specified.

• Delete Page
Deletes the current page.
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NOTE 1. Grayscale and color information of a grayscale or RGB color image will be lost upon
conversion into a monochrome image. The lost information is not restorable.

2. Color information of a RGB color image will be lost upon conversion into a grayscale image.
The lost information is not restorable.

• Copy Page
Copies the current page.

• Add Page
Adds new pages from file to documents.
Adds new pages from TWAIN scanner to documents.
(The TWAIN Mode is not available in this model.)

• Insert Page
Inserts a page from file to the current position.
Inserts a page from TWAIN scanner to the current position.
(The TWAIN Mode is not available in this model.)

• Replace Page
Replaces the current page from file with a new page.
Replaces the current page from TWAIN scanner with a new
page.
(The TWAIN Mode is not available in this model.)

• Rotate Page
- Rotate Left

Rotates the page 90 degrees counterclockwise.
- Rotate 180 Degrees

Rotates the page 180 degrees
- Rotate Right

Rotates the page 90 degrees clockwise.

• Adjust Page
- Correct Skew

Adjusts orientation.
- Eliminate Noise

Eliminates the noise.
- Enhance Edge

Enhances the edge.
- Brightness/Contrast

Adjusts brightness or contrast.
- Hue/Chroma

Adjusts hue or chroma.
- Reverse Gradation

Reverse Gradation.
- Monochrome (See Note 1)

Converts to Monochrome.
- Grayscale (See Note 2)

Converts to Grayscale.
- RGB

Converts to RGB full color.
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Page Menu

• Copy Page to Clipboard

Copies the entire page selected onto the clipboard.

• Copy Select Area
Copies select area to clipboard.

• Select All Pages
Selects all pages.
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• Drag Mode
Sets to the Drag Mode.

• Clip Mode
Sets to the Clip Mode.

• Edit Mode
Sets to the Edit Mode.

• Zoom In
Zooms in on an image.

• Zoom Out
Zooms out on an image.

• Fits to Page Width
Fits the display to the page width.

• Fits to Page Height
Fits the display to the page height.

• Full Page
Fits the display to the full size page.

• 25% - 200%
Shows the display at 25% - 200%.

• Detailed Settings
Sets detailed settings, such as thumbnail or page image settings.

View Menu
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Annotation Menu
• Show Annotation

The check box on/off setting specifies whether to display an 
annotation in the page list thumbnail.

• Set Annotation
Protects the annotation from reediting.

• Annotation Order
- Change Annotation Order to the Top
- Change Annotation Order to the Last
- Change Annotation Order to the Previous
- Change Annotation Order to the Next

• Create Annotation
- Text

Creates a text annotation and pastes it to a page.
- Line

Creates a line annotation and pastes it to a page.
- Rectangle

Creates a rectangular annotation and pastes it to a page.
- Ellipse

Creates an ellipse annotation and pastes it to a page.
- White block

Creates a white rectangular (solid white fill color) annotation 
and pastes it to a page.

- Black block
Creates a black rectangular (solid black fill color) annotation 
and pastes it to a page.

- Marker
Create a marker annotation and pastes it to a page.

- Label
Creates a label annotation and pastes it to a page.

- Stamp
Creates a stamp annotation and pastes it to a page.

- Date
Creates a date annotation and pastes it to a page.

- Page No
Creates a page number annotation and pastes it to a page.
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• Header
Edits a header common to each page.

• Footer
Edits a footer common to each page.

• Edit Text
Sets a format of the text in a selected annotation.

• Properties
Displays annotation properties.
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Annotation Menu
NOTE 1. To specify text font and colors, select the drawn text and select Properties in the Annotation
menu. The Text Format Setup dialog box can be displayed also by selecting Properties in the
pop-up menu, that appears by right-clicking on a drawn text.

2. To specify the thickness and color of a line, select the desired icon depiction then select
Properties in the Annotation. The color can also be specified by right clicking on the desired
icon marker to display the Properties menu and making a selection in the Graphic Format
Setup Dialog box.

3. To specify the thickness and colors of the rectangular Annotation, select the desired icon
depiction then select Properties in the Annotation. The color can also be specified by right
clicking on the desired icon marker to display the Properties menu and making a selection in
the Graphic Format Setup Dialog box.

• Text
Creates a text annotation. Select text annotation in the 
annotation menu (or tool button), and drag the mouse in the 
image window to specify the display position.
A dialog box for text setup will appear.
Enter the text to display, and then specify text color and font. 
(See Note 1)

• Line
Creates a line annotation.
Select line annotation in the annotation menu (or tool button 
(see Note 2)), and drag the mouse in the image window to 
draw lines.

• Rectangle
Creates a rectangular annotation.
Select rectangle annotation in the annotation menu (or tool 
button (see Note 3)), and drag the mouse in the image 
window to draw a rectangle.
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NOTE 1. To specify the thickness and colors of the ellipse border, select the desired icon depiction then
select Properties in the Annotation menu.  The color can also be specified by right clicking on
the desired icon marker to display the Properties menu and making the selection in the
Graphic Format Setup Dialog box.

• Ellipse
Creates an ellipse annotation.
Select ellipse annotation in the annotation menu (or tool 
button (see Note 1)), and drag the mouse in the image 
window to draw an ellipse.
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Annotation Menu
NOTE 1. To specify lines and colors of solid white or solid black, select the desired icon depiction then
select Properties in the Annotation menu. The color can also be specified by right clicking on
the desired icon depiction to display the Properties menu and making a selection in the
Graphic Format Setup Dialog box.

• White block
Creates a white rectangle (solid white fill color) annotation.
Select white annotation in the annotation menu (or tool button 
(see Note 1)), and drag the mouse in the image window to 
draw a white rectangle.

• Black block
Creates a black rectangle (solid black fill color) annotation.
Select black annotation in the annotation menu (or tool button 
(see Note 1)), and drag the mouse in the image window to 
draw a black rectangle.
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NOTE 1. To specify the color of a depiction, or the color and font of a label, select the desired icon
depiction then select Properties in the Annotation menu. The color can also be specified by
right clicking on the desired icon marker to display the Properties menu and making a
selection in the Graphic Format Setup Dialog box.

• Marker
Creates a marker annotation.
Select marker annotation in the annotation menu (or tool 
button (see Note 1)), and drag the mouse in the image 
window to draw a marker.

• Label
Creates a label annotation.
Select label annotation in the annotation menu (or tool 
buttons (see Note 1)), and drag the mouse in the image 
window to draw label displays Text Format Setup dialog box.
Enter text to display and specify text color and font.
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Annotation Menu

• Stamp

Creates a stamp annotation.
The stamp annotation pastes another image file like a stamp.
Select stamp annotation in the annotation menu (or tool 

button) and click the  button. Then drag the 
mouse in the image window to specify the area, displaying the 
stamp.

Click the  button to select image files to be used as 
a stamp.

OK

Add
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NOTE 1. To specify the color or font of the date, select the desired icon depiction then select Properties
in the Annotation menu.  The color can also be specified by right clicking on the desired icon
depiction to display the Properties menu and making a selection in the Graphic Format Setup
Dialog box.

• Date
Creates a date annotation.
Select date annotation in the annotation menu (or tool 
button), and drag the mouse in the image window to specify 
the area.
Specify the format, color, and font of the date to be displayed. 
(See Note 1)

1. Font Name
Specify the font here.

2. Style
Specify the font style.

3. Size
Specify the font size.

4. Text Color
Select the text color here.

5. Date
Specify the date here. Selecting from the calendar or 
entering the date.

6. Format
Specify the display format here.

7. Text Align
Specify the text alignment.
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Annotation Menu

• Page No

Creates a page number annotation.
Select page number annotation in the annotation menu (or 
tool button), and drag the mouse in the image window to 
specify the area. Double-click the Page No area to display the 
text the settings dialog box.
Specify format, color, and font of the page number to be 
displayed.

1. Font Name
Specify the font here.

2. Style
Specify the font style.

3. Size
Specify the font size.

4. Text Color
Select the text color here.

5. Text Align
Specify the text alignment.

Click on the drawn figure and select Properties to change the
thickness and colors of the lines.

1. Line Width
Specify the thickness of the lines here.

2. Line Style
Specify the types of lines here

3. Line Color
Specify the color of the lines here.

4. Fill Color
Select the color for solid painting here.

5. Semitransparent
Set the image to transparent.

6. Arrow Style
Select the Arrow style.
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• Main Tool Bar
Show/hide main toolbar.

• Page Tool Bar
Show/hide page toolbar.

• Annotation Tool Bar
Show/hide annotation toolbar.

• Image Tool Bar
Show/hide image toolbar.

• Status Bar
Show/hide status bar.

• Page list
Show/hide page list.

• Ruler
Show/hide ruler.

• Plugin
Show/hide plug-in.

Window Menu
141
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Network Scanner

Startup Windows, and select Panasonic → Panasonic Document Management System → Panasonic
Communications Utility in Programs from the Start menu.
The Panasonic Communications Utility is activated and the icon appears on the Task Bar.

• Scanner reception notification
Right-click the Panasonic Communications Utility icon to the Scanner Reception Notification either Pop
up Display or Icon Display.

<Pop up Display>
Displays the following message when the scanned image is received.

<Icon Display>
Changes the Panasonic Communications Utility icon when the scanned image is received.

<No Notice>
No notification message is shown on your PC even when the scanned image is received.

• Scanner Configuration
Right-click on the icon and select Scanner Configuration....

Network Scanner Settings
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The Scanner Configuration Window appears as shown below.

• Launch application
Select the application that will receive the scanner's data (Document Manager / Windows Explorer or
Other Application).
 

• Application
Select the application program path to open the scanned image.

• Save As File Type
Select the file type for saving the scanned image.

• Save To
Select the path to save the scanned image.

• Scanner reception notice
Select the viewing mode for the scanner reception notice.

<Address Information>
Select one of the following:

Auto Registration - Your PC's Address Information will be automatically registered into 
the Address Book of the device(s).

Manual registration at scanner - Manually register your PC's Address Information into the Address 
Book of the device.

 button

   To register your PC address information onto the devices located on the different subnet, click

   the  button. 

   Click the  button and enter the IP addresses of the devices.

Add Device

Add Device
143Continued on the next page...
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Network Scanner Settings

• Name

Specifies your PC Name to be registered to the device(s).
• Key Name

Specifies the Key Name to be registered to the device(s).
• Group ID

Specifies the Group ID to register your PC's Address Information to the device(s) on your network.
The Group ID will be compared with the General Settings on the device(s) when connecting to your PC. 
When a match is found, the Address Information will be registered to the device(s).
Scanner Setting (Key Operator Mode) : For UF-7000/7100/8000/8100 users
Set the Parameter No. 01 "ABBR Group ID" number (0-99) to match the Group ID programmed in the
Scanner Configuration.
General Setting (Key Operator Mode) : For UF-9000 users 
Set the Parameter No. 27 "ABBR Group ID" number (0-99) to match the Group ID programmed in the
Scanner Configuration.

• Address Renewal Interval
Set the time interval for updating the address information to the device(s).
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Right-click on the icon and select Panasonic Communications Utility.
The Panasonic Communications Utility Window appears as shown below.

Set to activate program when double-clicking the Panasonic Communications Utility Icon.

• Scanner Configuration
Open the Scanner Configuration Window.

• Fax Recv log (When the Panafax Desktop is installed)
Open the Fax Receive Log Window.

• Exit Panasonic Communications Utility
The Panasonic Communications Utility is terminated.

• Other

Click the  button to set the application program.

Panasonic Communications Utility

Browse
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The Remote Copy Utility is installed on your PC as part of the Panasonic-DMS software.
This utility allows you to copy documents Scanned on the machine and have them printed on any printer.
With the machine's Color Scanning capabilities, this allows you to Remote Copy color documents.

When receiving a print file from the machine, the Remote Copy Utility selects the printer configured on your
PC and starts printing the file with the preset properties.

Note: 1. Your PC will select the default printer if another printer was not pre-configured for the utility after
the Panasonic-DMS software installation.

2. Make sure that your PC is logged in when using this feature, or the print file will not transfer to
the remote printer.

Remote Copy (DP-180/190 and UF-9000 only)

UF-9000, DP-180/190
(i.e. Scan in Color mode)

Your Network

Your PC

1. Scan

3. Print

2. Send to Your PC

Your Pre-configured 
Printer (i.e. Color Printer)
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Selecting Panasonic → Panasonic Document Management System → Remote Copy Configuration
from Programs on the Start menu will display the configuration window.

1. Printer
Selects the printer to print the scanned document(s) to. 

2. Paper
Select the document size.

3. Orientation
Specifies how the document is positioned on the page. Portrait orients the print vertically. Landscape
orients the print horizontally. If available, Rotated Landscape rotates the paper 90 degrees
counterclockwise.

4. Print Job Setting
When printing a large amount of a multiple colored file, it may take a long time to print out all the pages.
In this case, select Print Each Page With Individual Print Job in order to print the first page quicker.
The total time to print all the pages will be the same in either setting.

Note: 1. The N in 1 feature is not available if the Print Each Page With Individual Print Job is
selected.

2. When printing a document in grayscale or monochrome mode, only the Print All Page With
One Print Job selection is enabled in the Print Job Setting.

5. Collation
Organizes numbered pages when you print multiple copies of a document. A complete copy of the
document is printed before the first page of the next copy is printed. 

Note: 1. Collation is not available if the Print Each Page With Individual Print Job is selected in the
Print Job Setting.

2. Even if collation can be specified within the printer driver, its activation is based on the Remote
Copy Configuration window setting.

6. Horizontal Position and Vertical Position
Adjust the printing position on the sheet.

7. Print Size
Selects printing in original size or printing within the printable area of the printer. 
147Continued on the next page...
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Remote Copy (DP-180/190 and UF-9000 only)
8. Print Page Frame
Select to print with page frame.

9. Rotate To Match Page Size
Select to rotate to match with the page size.



D
oc

um
en

t M
an

ag
em

en
t 

Sy
st

em
 S

ec
tio

n

Panafax Desktop

Panafax Desktop is a PC Faxing application specifically designed to compliment the Panasonic line of 
multi-function products.

Document(s) created on the PC can be easily faxed to a remote location directly, without having to print a 
hard copy first and then using the fax machine to send. This improves the copy quality received at the 
remote location, saving the cost and time of printing the hard copy locally before faxing it.

Compatible Models

 Network Connected Models

 Group 1
- DP-180/190
- DP-1820P/1820E with Fax and Internet Fax Options
- DP-2310/3010 with Fax and Internet Fax Options
- DP-3510/3520/4510/4520/6010/6020 with Fax and Internet Fax Options
- DX-600 / 800
- UF-7000/7100/8000/8100 with Internet Fax/Email Module
- UF-9000

 Group 2
- DP-1810F with Internet Fax Option
- DP-2000/2500/3000 with Fax and Internet Fax Options
- DX-1000/2000

 Local Connected Models
- UF-490/525 (USA UF-490: Standalone System only)
- UF-590/790
- UF-890/990 (Tx only)
- DP-1810F

Restriction(s)

Common
- The size of the data that can be transmitted is limited to the size that is within the memory of the 

device. The transmission is canceled when the device’s memory overflows during the transfer of the 
fax data. 

- The maximum number of multi-station transmissions is 999.

Network Connected Models Only
- The total number of direct dialing stations of the device limits the total number of stations that a fax 

message can be transmitted to. The transmission is canceled when it exceeds that number during the 
data transfer to the device from the PC.

- For Simple Send Only System with Group 2 Device(s), the fax data is transferred to the device 
continuously without confirmation of the job. The transmission is canceled when it exceeds the 
maximum number of stations, number of jobs or memory size of the device during data transfer to the 
device from the PC.

- For Simple Send Only System or Send and Receive System with Group 1 Device(s), the fax data 
is transferred individually from the Panafax Desktop while obtaining the completion confirmation for 
each job, by means of the Job Completion Notice (Send Only) or Communication Journal (Send and 
Receive).

If you are running Anti-virus Software, it may interfere and/or cause the Panafax Desktop from sending 
a PC Fax Job to the Device properly. You may be required to disable the Anti-virus software when 
using the Panafax Desktop temporarily. Please consult your Network Administrator.

General Description
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For the Network Connected Models
There are two types of Panafax Desktop configurations, Simple Send Only System and Send & Receive
Network Shared System.

Note:
*1: The result of the Simple Send Only System transmission with Group 2 Device models (refer to the list of 

compatible models in the previous section), the Send Log and TX Confirmation Notice confirms the 
transfer to the device only. The only way to confirm whether it reached the final destination is with a 
transaction journal of the device. (PAGES column on the Transaction Journal is mentioned as a hyphen 
"-".)

 
*2: The result of the Simple Send Only System and Send and Receive System transmission with Group 1 

Device models and all other compatible models, is reflected in the Send Log and TX Confirmation 
Notice. (Actual Pages Sent)

Simple Send Only System Connection Diagram

Connection Configurations (For the Network Connected Models)

Device Setting PC Fax Setting

Simple Send Only System
• Peer To Peer Connection
• Email Server Not Required

• IP Address settings
• Relay XMT Password setting
• Relay XMT Report = Off setting*1

• Relay XMT Password setting

Send & Receive Network
• Shared Network Connection
• Email Server and RX Email 

Account Required

• IP Address settings
• Relay XMT Password setting
• Relay XMT Report = Always setting*2
• Internet Fax setting
• Fax Forward setting

• For the Server PC
- Email Address settings
- Relay XMT Password setting
- Server setting
- POP Receive setting
- For the Client PC
- Search Shared Server setting

aaa bbb
aaa bbb

Transfer Fax Data

Transmit

Send FAX
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Send & Receive Shared Network System Connection Diagram

aaa cccbbb

ddd

aaa

ddd

bbb

ddd

Transfer Fax Data Transfer
Fax Data

View Shared Folders POP Receive

Transmit

Receive

Send FAX

Panafax Desktop
Client PC

Panafax Desktop
Client PC

Panafax Desktop
Client PC

Panafax Desktop
Server PC

Panafax Desktop
Client PC

Panafax Desktop
Server PC

Receive FAX

Fax Forward

LAN

LAN

ccc

ddd

Email
Server

Email
Server
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For Local Connected Models
There are two types of Panafax Desktop configurations, the Standalone System and the Network Shared
System.

Standalone System

Connection Configurations (For Local Connected Models)

Device setting PC Fax Setting
Standalone System
- Standalone Connection

- PC-FAX RCV MODE =   Print / Upload & Print / Upload - None

Network Shared System
- Shared Network Connection

- PC-FAX RCV MODE =   Print / Upload & Print / Upload For the Server PC
- Server Setting
For the Client PC
- Search Shared Server setting

aaaaaa

Transfer Fax
Data

Send
Parallel Cable

dddddd

Transfer Fax
Data

Receive
Parallel Cable

Send FAX

Receive FAX
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Network Shared System

aaa cccbbb

ddd

aaa

ddd

bbb

ddd

Transfer Fax Data

View Shared Folders

Transmit

Receive

Send FAX

Panafax Desktop
Client PC

Panafax Desktop
Client PC

Panafax Desktop
Client PC

Panafax Desktop
Server PC

Panafax Desktop
Client PC

Panafax Desktop
Server PC

Parallel Cable

Parallel Cable

Download
Fax Data

Upload
Fax Data

Receive FAX

LAN

LAN

ccc

ddd
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For the Network Connected Models
Panafax Desktop uses the fax modem in the Panasonic/Panafax models connected on your network (LAN)
for fax communication. 
Before using the Panafax Desktop, it is necessary to activate the Fax Modem and to setup certain
parameters. Follow the steps below to setup the Panafax Desktop.

Installation

Installation and Setup (For the Network Connected Models)

1 Confirm the following device settings. 

Send Only System settings:
Connection to the network
Set Internet parameters:

- IP Address
- Subnet Mask
- Default Gateway IP Address
- Relay XMT Password

Set Fax Parameters:
- Set the Relay XMT Report = Off (Fax Parameter No. 143. See the Operating Instructions for Facsimile and 

Internet Fax/Email)

Send & Receive System settings:
Connection to the network
Set Internet parameters:

- IP Address
- Subnet Mask
- Default Gateway IP Address
- Email Address
- Email Server Name/IP Address
- Relay XMT Password

Set Fax Parameters:
- Set the Relay XMT Report = Always (Fax Parameter No. 143. See the Operating Instructions for Facsimile 

and Internet Fax/Email)
- Set the Fax Forward to Receive Email Account (Fax Parameter No. 054. See the Operating Instructions for 

Facsimile and Internet Fax/Email)

2 Install the Document Management System.
Refer to the Installation section of this Operating Instructions.

Note: 
For DP-1810F/DP-1810F (Network PC Fax)/2000/2310/2500/3000/3010/3510/3520/4510/4520/6010/6020, UF-
7000/7100/8000/8100 the Panafax Desktop is not installed automatically with the TYPICAL installation. Select 
CUSTOM installation and check the Panafax Desktop to be installed.
For the DP-1810F there are two types of Panafax Desktop connections (Parallel and Network). The "DP-1810F 
(Network PC Fax)" model name is selected when using the Network version of the Panafax Desktop and "DP-
1810F" is selected when using the Local (Parallel) version of the Panafax Desktop.
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Basic Setup (Send Only System /Send & Receive System)

1 Double-click the  icon on the Windows Desktop.

The Panafax Desktop appears.

Click the  button.

Note: When the Panafax Desktop has already been 
activated, the Main Window of the Panafax 
Desktop is shown on your PC. Select PC Fax 
Device Locator from the Tools menu to open the 
Device Search Ranges window.

2 Device Search Ranges appears.

Click the  button to start searching for the 

Network Connected Devices.

Note: It searches for all the devices within the default 
Subnet. Refine the search range when there are 
many devices connected in the Subnet, or you 
want to connect to devices outside of the Subnet. 

To change the search range, click the  
button and specify the range.

OK

Search Now

Add
155Continued on the next page...
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Installation and Setup (For the Network Connected Models)
3 Starts searching for the PC Fax devices on the network.

4 The Network connected PC Fax device(s) are listed in the 
PC Fax Device Locator.
Select the desired Device and double-click or select 
Properties from the Device menu.
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5 The PC Fax Properties appears.
<General> Tab
Input the PC Fax Settings.
Send Only System:

• Device's Email Address
It is not necessary to enter any Email Address.

• Device’s Relay XMT Password
The Relay XMT Password of the device.

• Result Report Email Address
This Setting is unnecessary. (See Note 1 and 3)

Send & Receive System:
• Device's Email Address

Set the Email Address of the device. (See Note 2)
• Device's Relay XMT Password

The Relay XMT Password of the device.
• Result Report Email Address

Set the POP Email Address for the reception. (See Note 3)
Note: 1. If you have your own Email Address and your device is 

set up to Internet Fax, set your Email Address here. 
You can receive the Result Report from the device. In 
that case, set the Relay XMT Report = Always (Fax 
Parameter No. 143).

2. The email address is used to distinguish the device. 
Input it precisely, otherwise the Device Name and 
Device Location on the Receive Log may not be 
indicated properly. 

3.When the Relay Domain is set in the User Parameters 
of the device, it is required to be the within the same 
domain (The right part of @) of the Email address for 
the Result Report Email Address. If it doesn't 
correspond, transmission from the Panafax Desktop is 
rejected. 

<Transmission/Reception> Tab
• Transmission Setting

- Transmission Priority
If there are multiple devices available, you can set the 
transmit priority of the device.

- Dept. counter mode On
When the Department Code function is being used at the 
device, check the box and input the Identification Code

- Start Status Monitor at sending
Starts Status Monitor is automatically activated at sending. 
The condition of the device can be monitored. 
The Device Group 2 doesn't have this function.

• Reception Setting (Send & Receive System only)
- Makes Reception Effective

Check this box if you want to enable reception with this 
device.

• Acquires Phone Book data from the device
- Device's Password

Device's Password to acquire the phone book data from 
the device, it is required to set the same password as the 
Password of the device. 

Note: 1.The DX-600/800 uses the Remote Password. The DP-
1810F/2310/3010/3510/3520/4510/4520/6010/6020/
UF-7000/7100/8000/8100/9000 uses the Key Operator 
Password.

2.The Device Group 2 doesn't have this function.

Click the  button when you finish inputting the 
settings.

OK
157Continued on the next page...
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Installation and Setup (For the Network Connected Models)
Receive Setup (Send & Receive System only)

6 Confirm that the device's Condition is in Standby (It takes 
a little while) using the PC Fax Device Locator.

Click the  or select Device | Exit from the menu to 
close the PC Fax Device Locator.
For the Send Only System, the setup is completed.
For the Send & Receive System, continue to the 
Receive Setup on the next section. 

1 Click the  icon on the Windows Desktop.

The Panafax Desktop appears.
Select Tools | PC Fax Device Locator from the main 
menu.

2 The PC Fax Device Locator appears.
Select Device | Detail Settings from the menu.

x
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3 The Detail Settings appears.
• Fax Log Data Folder

- Location
Specify the location to save the Fax log data. The 
default setting is generally acceptable.

• Shared Server Settings
- The Shared and Account Name 

Set up when Panafax Desktop is used in shared 
mode.

• POP Server Settings for PC Fax Reception
- This is set up when Panafax Desktop uses the 

Receive function.
POP Server settings and the receiving Email 
Account.

• PC Fax Transmit Setting
- Max. number of Multi-Station TX

Set up the maximum number of destinations to 
transmit to during one transmit request to a 
device. 
If the number of the destinations exceed this 
number, it will be divided into more than one 
transmission. When it is divided into several 
transmissions, and there are other devices 
available, it will transmit a request to multiple 
devices.

Click the  button when you finish inputting 

the settings.
Note: 1. If your PC is running Windows NT/Windows 

2000/Windows XP/Windows Server 2003 
and the client PC is running Windows 98/
Windows Me, it is necessary to use the Guest 
Account to use the Fax Server function. If a 
message "Do you want to use the Guest 
Account?" comes up, click [Yes] to use the 
Guest Account.

2.When the Guest Account is enabled, a 
security problem may occur.

-It will be possible to access common 
folders even if there is no account in 
Windows

-The possibility that a computer virus could 
enter through this account.

Please set it after you confer with the Network 
Administrator.

4 Select the desired Device and double-click or Click on 
Properties from the Device menu.

OK
159Continued on the next page...



Panafax Desktop

160

Installation and Setup (For the Network Connected Models)
5 The PC Fax Properties appears.
Click Transmission/Reception tab and check the 
"Makes Reception Effective" box.

Click the  button.

6 Confirm that the Reception status displays "Yes". It 
takes a moment.

Click the  or select Device | Exit from the menu to 
close the PC Fax Device Locator.

The Send & Receive System setup is completed.

OK

x
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Client Setup (Send & Receive System)

1 Click the  icon on the Windows Desktop.

The Panafax Desktop appears.

Click the  button.

2 Device Search Ranges appears.
Click on the [Shared Network Connected 
Device(s)] radio button.

Click the  button to start searching the 

shared Server.

Note: Searching  sometimes may take a long time 
when there are many PCs connected to your 
network. In this case, we recommend  to click 
[Add] button and specify the Domain or 
Workgroup, or specify the Computer Name 
directory to reduce the searching time.

Look in
• Specified Domain or Workgroup

Input device's Domain or Workgroup.
• Specified Computer Name

Input the Server Computer Name.
• Shared Name

Input the Server Shared Name if you changed 
from the default setting.

• Password
Input the Server Password if you changed from 
the default setting.

OK

Search Now
161Continued on the next page...
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Installation and Setup (For the Network Connected Models)
3 Start searching the Server for Network connected 
Devices.

4 The Network connected device via Server is listed in 
the PC Fax Device Locator.

Click the  or select Device | Exit from the menu to
close the PC Fax Device Locator.

Note: The reception function is shown as "Yes" if the 
shared device's reception function is effective. If 
you do not wish to receive faxes, select the 
Device and double-click or Click Device | 
Properties from the menu.The PC Fax (Shared 
Device) Properties appears.Click 
Transmission/Reception  tab and checkout the 
box for "Makes Reception Effective". Click the 

 button.

x

OK
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For Local Connected Models
Panafax Desktop uses the fax modem in the Panasonic/Panafax models connected with your computer by
parallel cable. 
Before using the Panafax Desktop, it is necessary to activate the Fax Modem and to setup certain
parameters. Follow the steps below to setup the Panafax Desktop.

Installation and Setup (For the Local Connected Models)

1 Confirm the following settings of the device. 
If you wish to receive, change the following parameter 
as “Upload & Print” or “Upload”.
PC-FAX RCV MODE = Print / Upload & Print / Upload 
(Fax parameter No. 063)

2

or

Install the Document Management System.Refer to 
the Installation section of these Operating Instructions.

Note: 1.For the DP-1810F, the Panafax Desktop does 
not install automatically with the TYPICAL 
installation. Select CUSTOM installation and 
check the Panafax Desktop to be installed.
For the DP-1810F, there are two available 
types of connections (Parallel or Network).
The "DP-1810F (Network PC Fax)" model 
name is selected when using the Network 
version of the Panafax Desktop and "DP-
1810F" is selected when using the Local 
(Parallel) version of the Panafax Desktop.

2.For the Network Shared System, select the 

 button on the Select Setup 
Type screen during the installation.

Client
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Installation and Setup (For the Local Connected Models)

Setup for Standalone System 

Special settings are unnecessary. It will be ready to send and receive fax massages if the device and PC
are connected with the parallel cable and Panafax Desktop is started. 
Note: Confirm that the device is not in the Energy Server Mode or Sleep Mode when you start Panafax

Desktop.

Setup for Network Shared System
Server PC

Server Setup (Network Shared System)

1 Click the  icon on the Windows Desktop.

The Panafax Desktop window appears.
Select Tools → PC Fax Device Locator from the 
main menu.

2 The PC Fax Device Locator appears.
Select Device → Detail Settings from the menu.

3 The Detail Settings window appears.
Check the box for the “Shared Server Setting”.

Click the  button when you finish the 

settings.
• Fax Log Data Folder

Location
Specify the location to save the Fax log data. 
The default setting is usually all right.

• Shared Folder Settings
This is set up when Panafax Desktop is to be 
shared.

OK
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Client PC
Client Setup (Network Shared System)

1 Double-click the  icon on the Windows Desktop.

The Panafax Desktop window appears.

Click the  button.

Note: When the Panafax Desktop has already 
been activated, the Main Window of the 
Panafax Desktop is shown on your PC. 
Select PC Fax Device Locator from the 
Tools menu to open the Device Search 
Ranges window.

2 Device Search Ranges appears.

Click the  button to start searching the 

shared Server.

Note: Searching sometimes may take a long time 
when there are many PCs connected to your 
network. In this case, we recommend you to 

click the  button and specify the 
Domain or Workgroup, or specify the 
Computer Name directory to reduce the 
searching time.

• Look in
- Specification of Domain or Workgroup

Input the device’s Domain or Workgroup.
- Specification of Computer Name

Input the Server Computer Name.
- Shared Name

Input the Server Shared Name if you changed 
from the default setting.

• Password
Input the Server Password if it was changed from 
the default setting.

OK

Search Now

Add
165Continued on the next page...
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Installation and Setup (For the Local Connected Models)
3 Start searching the Server for Local connected 
Devices.

4 The Local connected devices via Server is listed in the 
PC Fax Device Locator.

Click the  or select Device → Exit from the menu 
to close the PC Fax Device Locator.

Note: The reception function is shown as "Yes" if the 
shared device's reception function is effective. If 
you do not wish to receive faxes, select the 
Device and double-click or Click 
Device Æ Properties from the menu.The PC 
Fax (Shared Device) Properties appears.Click 
Transmission/Reception tab and remove the 
check box of "Makes Reception Effective".

Click the  button.

x

OK
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Main Window

Main Window and Toolbar

(1) Fax No. Enter the destination fax number.

(2) Line Select Check the line type to dial the preset code before the telephone number.
See the Dialing Setting Tab of Configuration Menu.

(3) Recipient When this is entered, reflected on the cover sheet.

(4) Company When this is entered, reflected on the cover sheet.

(5) recipient(s) Indicates a number of entered station(s).

(6) Destination(s) Indicates entered destination station(s).

(7) Subject When this is entered, reflected on the cover sheet.

(8) Memo field When this is entered, reflected on the cover sheet.

(9) Cover Sheet Select various cover sheet or no cover sheet. 

(10) Attachment Indicates a number of pages attached. 

(11) Resolution Indicates a current sending resolution.

(1)

(2)

(3)
(4)

(5)

(6)

(7)

(8)

(9)
(10) (11)
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Main Window and Toolbar

Toolbar

Used to start the transmission.

Used to view the cover sheet or transmission file.

Used to select the file to be sent.

Used to show the Send/Receive Log Manager.

Used to open your personal Phone Book.

Used to create or edit a Cover Sheet.

Used to show the On-line help.
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Sending a Document via Windows Application
You can send a fax directly from any Windows Application by simply printing to the Panafax Desktop Driver.
For example, compose a document from your word processor application. When you are finished and ready
to fax it to a remote location, simply follow the procedure below.

Sending Document

1 From the current Application select Print from the File 
menu.

2 The Print dialog box appears.

Select Panafax Desktop Driver from the Printer Name 
menu.

Click the  button to convert the document 

into a Fax image.

3 Enter the recipient's Fax No., Name and Company or 
select your Personal Phone Book.

Note: To input a pause, use the comma ",".

Click the  button to enter the recipient to the recipient

list.
Enter/select another recipient if you desire.

Type the Subject in the Subject field and a brief message
to be included in the Cover Sheet.

Click the  icon when ready to send the fax.

Note: Click the  icon to verify the fax image to be

sent to the remote station(s).

OK
169Continued on the next page...
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Sending Document
4 Click the  button to start the transmission.OK
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Sending a Document via the Panafax Desktop
You can send a fax directly from a file made in any Windows Application by simply attaching the file via the
Panafax Desktop.
For example, compose a document from your word processor application. When you are finished and ready
to fax it to a remote location, simply follow the procedure below.

1 Click the  icon on the Windows Desktop.

The Panafax Desktop window appears.

Click the  icon to select a file for the 

transmission.

2 Select the file and click the  button to 

convert the document into a Fax image.

3 From the Panafax Desktop window, enter the 
recipient's Fax No., Name and Company or select 
from your Personal Phone Book.

Note: To input a pause, use the comma ",".

Click the  button to enter the recipient to the

recipient list.
Enter/select another recipient if you desire.
Type the Subject in the Subject field and a brief 
message to be included in the Cover Sheet.

Click the  icon when ready to send the fax.

Note: Click the  icon to verify the fax image to

be sent to the remote station(s).

Open
171Continued on the next page...
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Sending Document
Sending a fax memo by Panafax Desktop
You can send a fax memo directly from the Panafax Desktop. This memo can be sent quickly and easily.

4 Click the  button to start the transmission.

1 Click the  icon on the Windows Desktop.

The Panafax Desktop window appears.

2 From the Panafax Desktop window, enter the 
recipient's Fax No., Name and Company or select 
from your Personal Phone Book.

Note: To input a pause, use the comma ",".

Click the  button to enter the recipient to the 

recipient list.
Enter/select another recipient if you desire.
Type the Subject in the Subject field and a brief 
message to be included in the Cover Sheet.
If you wish, click Cover Sheet to change the Cover 
Sheet Type.

Click the  icon when ready to send the fax.

Note: Click the  icon to verify the fax image to 

be sent to the remote station(s).

3 Click the  button to start the transmission.

OK

OK
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Receive Setting

Receiving Document

1 Confirm the Panasonic Communications Utility icon is 
in the taskbar tray.

2 Right-click the Panasonic Communications Utility Icon 
to show the menu and select the PC-Fax Reception 
Notification.

• Popup Display
• Icon Display
• No Notice

When a fax is received on the machine, it will proceed as follows:

1 A receiving notice appears on the connected PC.

Click the  button.

or

The Panasonic Communications Utility icon is 
changed. 
Double click the icon.

2 The Receive Log appears.
Select a transaction from the log then click the 

 icon to view the received fax.

3 The received fax is displayed on the PC.

Receiving LOG
173
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To register a recipient to the Personal Phone Book, follow the steps below:

Registering the Personal Phone Book

1 Click the  icon to open the Phone Book dialog 

Box.

2 Click the  button.

Note: 1.Click the  
button to enable the retrieval of the phonebook 
data from the device.

2.To use the Acquire Device’s Phone Book 
function, the Key Operator's Password is 
required. See page 157 “Transmission/
Reception Tab | Acquires Phone Book data 
from the device”.

3. In case of a setup as a Client PC, only the Phone 
Book data can be acquired from the device by the 
Server PC.

4. Click the  button to edit the 
address.

5. Click the  button to delete the address.

3 <Contact> Tab
• Name:

Enter the recipient's name.
• Fax No.:

Enter the fax number.
• Call Type:

Select how the call should be dialed.
The code preset with the Tools/Configuration/
Dialing Settings is dialed ahead of the fax number.

Note:  To input a pause, use the comma (,).

4 <Data Fields> Tab
Enter the Company Name, Department, Job Title, 
Address, Direct Phone No. and the Extension Phone 
No. of the recipient to be used on the Cover Sheet.

Acquire Device's Phone Book

Personal Details

Delete
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To register a group of recipients, follow the steps below:

5 Click the  button to save the entry.
The maximum number of entries are 2000.
To add another entry, repeat procedure from the
step 2.

1 Click the  icon.

2 The Phone Book dialog box appears.

Click the  button.

3 The Group registration dialog box appears.

Click the  button.

4 The Add New Group Name dialog box appears.

Enter the group name and click the  

button.

OK

OK
175Continued on the next page...
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Registering the Personal Phone Book
5 Select the desired recipients.

6 Click the  button to add the recipient(s) to 

the Member List.
The maximum number of recipients are 999 for each 
group.
To add another group, repeat the procedure from step 
3.
The maximum number of group's are 100.

If finished, click the  button to exit Group 

registration.

OK
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To Import/Export CSV (Comma Separated Value) data From/To your Personal Phone Book
The telephone data in a CSV format file can be imported into your Personal Phone Book and the telephone 
data of your Personal Phone Book can be exported to a CSV file. 

Note: Though a pause usually is indicated as a comma (,) with Panafax Desktop, it is changed into "p" 
by the import and export of the CSV file. Please input a pause with "p" when you make a CSV file.

Importing from the CSV file

1 On the Phone Book dialog box, Select File | Import... 
from the menu.

2 Select the file to be imported and click the 

 button.

3 Confirm the contents of the Data Field and 
Addressbook Field match.
Select the Data Field you want to import to.

Select the item and click the  

button to change the field setting if the Data Field and 
Addressbook Field do not mach.

Click the  button if you completed.

Note: 1.Name and Fax No. of the Address book field 
are essential (minimum requirements).

2.The characters except for the following are 
prohibited for use in the Fax No. field. 
A telephone number or any data will not be 
imported if any of the prohibited characters are  
contained within it.
Effective characters: 1234567890*#p-/s
p = Pause
- = Separation mark (Not used for the dialing)  
/ = Tone change  
s = Sub-address  

Open

Change Mapping...

OK
177Continued on the next page...
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Registering the Personal Phone Book
4 The telephone data of the CSV file is imported into
your Phone Book.

Exporting to the CSV file

1 On the Phone Book dialog box, Select File | Export...
from the menu.

2 Enter the file name and click the  button

to save the CSV file.

Importing from the CSV file

OK
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The Cover Sheet is attached to the first page of every fax and contains information such as the recipient's
name, sender's name, date, title, etc.

Creating Cover Sheet

Cover Sheet

1 Click the  icon.

2 The Cover Sheet Editor window appears. 
Edit the Cover Sheet.
Select Save As from the File menu.

3 The Save As dialog box appears.
Select the Folder you wish to save to, or
you wish to save it into a the New Folder,

click the  button,

enter the New Folder Name,

and then click the  button.OK
179Continued on the next page...
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Cover Sheet
4 Enter the New Folder Name into the Cover Sheet File 
Name box.
Enter any comments into the Comment box if you 
wish.

Click the  button to save the New Cover 

Sheet.
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[Edit] menu

Undo : Undoes the last editing operation.

Cut : Deletes the selected text and copies it to the clipboard.

Copy : Copies the selected text onto the clipboard.

Paste : Pastes the text or object  from the clipboard.

Delete Object : Deletes the selected object.

Page Size : Sets the size of the cover sheet.

Date Frame : Inserts a date field.

Text Frame : Inserts a text box.

Line/Box : Inserts a line or box.

Image Frame : Inserts an existing image file (bmp file).

Recipient Details : Inserts the information set in the  and  tabs in the Personal Address
Book.

Sender Details : Inserts the information set in the  tab in the Tools menu.

Comments : Inserts a comment field for typing a brief message when sending a fax.

Subject : Inserts a subject field when sending a fax.

[View] menu

Show Grid : Displays a grid.

Preview : Displays the preview of the cover sheet.

Show Status Bar : Displays the status bar.

Zoom : Sets the ratio for the cover sheet editing screen.

Scale unit : Sets the scale unit of measure (cm/inch).

[Options] menu

Font : Specifies the character font.

Line Style : Specifies the line style.

Text Alignment : Adjusts the text position.

Date Format : Sets the date format.

Contact Data Fields

Sender Details
181
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Configuration Setting
Selecting Configuration... on the Tools menu, displays the configuration window.

Configuration Menu

Send Option Tab
Device Selection

• Device Name:
A device can be chosen here when more than one 
device is connected with network connected type 
devices.
Auto Selection 
Effective device is selected automatically by the 
priority setting order.
Rotation
Effective device is selected automatically in rotation 
order. (load balancing)
Device Name
Only the designated device is selected.

• Status/Location/Paper Size/Resolution:
When the device is specified, the attributes of the 
device are indicated.

Page Setup
• Resolution:

Resolution to be used for the transmission.
The selectable resolutions are dependent on the 
machine's capability connected to your PC.

• Setup Quality:
Set the quality to be used for the transmission.

• Use these as the default settings:
If checked, the settings selected are used each time 
a fax is sent.

Cover Sheet Tab
Setting the usage of the Cover Sheet.

• Cover Sheet with specified fields
The address information is inserted into the TO field 
of the Cover Sheet.
The transfer time to the device sometimes becomes 
long because the image data is sent to the device 
multiple times in the case of multi-station 
transmission.

• Cover Sheet with No specified fields (Generic)
The address information is NOT inserted into the 
TO field of the Cover Sheet.
The transfer to the device is done efficiently 
because the image data is sent to the device only 
once and only the address information is sent in the 
case of multi-station transmission.
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Dialing Settings Tab
Specify the local, long distance and Inter-office call 
access numbers. These access numbers are dialed 
before the phone numbers that are registered in the 
Personal Address Book depending on the Call Type 
settings.

Sender Details Tab
Used to identify senders from various information on the 
Cover Sheet when sending a fax.

PIN Code Tab
Specify the PIN Code settings when required by your 
telephone system.
Some countries do not support this function.

Various Settings Tab
• Device Phone Book

When this box is checked, the phone book data is 
acquired from the device at the time of startup, and 
it is added into the Personal Phone Book. 
When this is used on the client & server, this 
function is effective only on the server PC
The password must be preset for the device in the 
PC Fax Properties for the Network connected 
device.

• Notification Message
Various notices can be set up.
183
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Send/Receive Log
The transmission and the reception can be confirmed.

Send Log/Receive Log

1 Click the  icon.

2 Send/Receive Log window appears.
Click Send Log icon and Receive Log icon to switch 
between the Log windows.
Status column

• Queuing: Send fax is queuing.
• Executing: Transferring the data to the device
• Completed: Transferring the data is completed

Result
• OK: The fax transmission is completed 

from the device.
• Error Code: The fax transmission is incomplete 

from the device.

Note: 1.For the Network Device Version of Simple 
Send Only System with the Group 2 device 
models (Please refer to the Compatible 
Models in General Description portion of this 
Operation Instructions manual), the Send Log 
shows only when the transfer to the device 
succeeded (R-OK). “The fax sending is 
completed from the device” can be confirmed 
only by the Communication Journal of the 
device.

2.For Network Device Version of the Simple 
Send Only System, the Receiving Log is not 
available.

3.For the Network Device Version of the Simple 
Send & Receive System and Local Device 
Version of Network Shared System, there is 
an Administrator Send Log that can check all 
the client(s) sending transactions. Select 
General User to see the Own Send Log and 
Administrator to see the Administrator Send 
Log. The Administrator Send Log can be set 
up with a password for security. To see the 
Administrator Send Log, Login with 
Administrator mode and check View | 
Displays All Users Send Logs. from the menu 
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Save Log
The Send/Receive Log can be saved to a separate file.
At the default setting, when the log exceeds 999 transactions, the oldest entry is automatically deleted.
The log can be saved by following the steps below.

Manually Saving the Log

1 In the Log window, select the log transactions that you 
wish to save and click the [Save Log] icon.

2 Select the Folder that you want to save into and click 

the  button.

You can make a new folder by clicking the 

 button.

Note: The  button is not available on 
Windows NT/Windows 98.

3 Select whether you wish to Delete the Logs after 
saving them.

4 The tiff file data (.tif) and the transmission file log 
information file (.xml) are saved as a set.
The log list files (sendlog.html/recvlog.html) are made 
automatically in the same folder. They can be viewed 
with a Web browser (Internet Explorer 5.5 or better).

OK

New Folder

New Folder
185
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Send Log/Receive Log

Automatically Saving the Log

1 In the Log window, select Tools | Options from the
menu.

2 Option window appears.
Set the Save Log settings accordingly.
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Network Status Monitor

Select Panasonic → Panasonic Document Management System → Network MFP Utilities → Network
Device Locator in Programs from the Start menu.
Upon activation of the Network Device Locator, the attached printers will be automatically searched and
displayed in the list.

List of Contents

Right-click on your device to display the menu.

1. Status Monitor
Activates the Status Monitor.

2. Configuration Editor
Activates the Network Configuration Editor (see page 198).

3. Address Book Editor
Activates the Address Book Editor (see page 198).

4. Delete
Removes the device from the list.

5. Rename
Changes the name of the device.

6. Search
• Device Search

Search the devices manually.

• Device Search Ranges
Set the conditions to search the devices (see page 188).

7. Create Shortcut
Creates a Shortcut of the program for the selected device.

8. Delete Shortcut
Deletes the selected Shortcut.

Network Device Locator

Item Status
Device Name Name of the device.

Location Location of the device.

IP Address IP address of the connected device.

Make/Model Make and model number of the device.

Condition Display of Normal, Warning, Error, Power Saving, etc will be indicated after the
status of the connected device is detected.
187
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Network Device Locator

� � � � Device Search Condition

Select Search → Device Search Ranges from the Device Menu.

1. Panasonic Printers
Select if searching for Panasonic printers only.

2. All Printers
Select if searching for all printers.

3. Add
Add a new search range of IP addresses.

Click the  button and enter the Start IP Address and End IP Address.

4. Edit
Edit the selected IP address range.

5. Delete
Delete the selected IP Address range.

6. Detail
Enter the SNMP community name of the devices to be searched.

Add
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The Status Monitor is a Multi Functional Product (MFP) utility that monitors and displays the current status of
connected devices.
Upon activation, the icon of the Status Monitor (up to 10 different printers) appear on the System Tray next
to the system clock.

The Status Monitor indicates the device status by the icon lamp color as listed below.

Task Display

Lamp Status
Green Device is operational in standby, printing, scanning, or copying mode.

Yellow Device attention is required, check paper supply, etc.

Red Toner needs replacement, cover is open, paper jam, or device failure.

Gray Device is in Energy Saver (sleep) Mode.
189
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Right-clicking the Status Monitor icon in the System Tray displays the following pop-up menu.

1. Open Status Monitor
Displays details about the current status of the device.

2. Start the Configuration Editor
Activates the Configuration Editor.  (See page 198)

3. Start the Address Book Editor
Activates the Address Book Editor.  (See page 198)

4. Auto Start
Sets the Status Monitor for the device to start automatically when the PC is rebooted.

5. Job Completion Notice
Sets the Job Completion Notification mode.  (See page 196)

6. Message Display
Displays the contents (file name, etc.) of the Job Completion Notice when it is set to Icon (No Notice).

7. Pops-up When Error Occurs
Selects whether a pop-up error message box appears when an error occurs on the connected device.

8. About
Displays the version information about the Status Monitor.

9. Exit
Closes the Status Monitor.

Taskbar Menu
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Right-clicking the Status Monitor icon in the System Tray and selecting Open Status Monitor in the pop-up
menu displays the Status Monitor dialog box.

� � � � Status Tab

1. Model
Displays the name and model number of the connected device.

2. Status
Displays the current status of the device.
If two or more items have been detected, clicking the  /  buttons allows viewing of other
items.

3. Control Panel
Displays information as it appears on the panel of the device.
If two or more items have been detected, clicking the  /  buttons allows viewing of other items.

4. Message
Displays the device details of the current status.
If two or more items have been detected, clicking the  /  buttons allows viewing of other
items.
191
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� � � � Configuration Tab

1. Model
Displays the name and model number of the connected device.

2. Configuration
Displays a list with the current device configuration (optional devices, etc.).

3. Status
Displays the communication status between the Status Monitor and the device.
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���� Paper Tab

The Paper tab displays the type, size, and paper status of each paper tray.
A user comment can be entered in the Paper Type field.
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���� Network Tab

1. Model
Displays the name and model number of the connected device.

2. Network Information
Displays a list of the current network status. (Number of packets for Sending/Receiving etc.)
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���� Job List Tab

1. Model
Displays the name and model number of the connected device.

2. Job List
Displays the current print jobs.
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Before using the Job Completion Notice, choose the Status Monitor as follows:

• Pop up Display
Displays the following message when the print or PC fax job is completed.

Job Completion Notice

Pop up Display : Notifies with the Pop-up message.

Icon (Notice) : Notifies with the Icon appearance on the desktop and change the Status Monitor
icon.

Icon (No Notice) : Notifies with the Status Monitor icon.
None : Does not notify.
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• Icon (Notice) and Icon (No Notice)

Displays the Notification Icon  on your desktop if Icon (Notice) is selected, and changes the Status

Monitor icon.

Select the Message Display to show a message.

Status Monitor icon
197
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Network Configuration Editor/Address Book Editor

These utilities allow you to edit the device’s Configuration or Address Book through a TCP/IP LAN network 
using the FTP protocol. The desired device is first selected from the device list of the Network Device 
Locator and then the Network Configuration Editor or Network Address Book Editor can be started.

Note:
1. Both utilities are installed when the "Administrator" mode is selected during the Panasonic-DMS 

installation (see page 96).
2. The following message is shown when retrieving the data from a device if the software modules have 

not been installed to your PC. Click the  button to download the modules from the Web site.

The compatible devices are listed in the Supported Models List. 
Select Help → Supported Models... to open the list. You can access the Web site by clicking the 

 button on the window.

General Description

Update

Update
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Activation Procedure

1 Start the Network Device Locator. (See page 
187)

2 The Network Device Locator appears.
From the Toolbar
Select the device from the list and click the 

 or  icon.

From the Tools menu
Select the device in the list and select 
Configuration Editor or Address Book 
Editor from the Tools menu.

3 The Network Configuration Editor or Network 
Address Book Editor appears and retrieves 
the data from the device.
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Create Shortcut Links

1 Start the Network Device Locator. (See page 
187)

2 Click on the device and select Create 
Shortcut → Configuration Editor or 
Address Book Editor from the Tools menu.

3 The Shortcut Preparation window appears.

Select a Preparation Place and click the 

 button.

Note: As the shortcut or menu icon 
includes the IP Address, the shortcut 
or menu icon has to be recreated 
each time if the IP Address of the 
device is obtained using a DHCP 
server on the network.

4 The shortcut link is created at the selected 
place.

Create
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Menus and Icons

Main Window

Help Bar: Input or operation guide help is indicated.

Status Indicator: Communication status and the latest communication result are indicated.

Menu Toolbar 
Icon Description

File
New Creates a new blank file.

Open Opens an existing file.

Close Closes the active file.

Save Saves the settings to a file with its current name.

Save As Saves the settings to a file with a new name.

File Information Displays or changes the addresses of the device.

Font Selects the font which is printed on reports.

Print Prints the active folder content.

Delete Deletes the file.

Export Exports the active folder contents to a text file.

Import Imports the active contents from a text file.

Exit Shuts down the application.

Quit Closes the active window without saving data.

Help Bar Status Indicator Help Bar Status Indicator

Network Configuration Editor Address Book Editor
201
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Main Window
Menu Toolbar 
Icon Description

Edit Cut Removes selected lines and places them on the clipboard.

Copy Copies selected lines to the clipboard.

Paste Pastes the contents of the clipboard at the insertion point of the
line.

Insert Line Inserts a line at the insertion point of the line.

Delete Line Deletes a line at the deletion point of the line.

Find Parameter Searches for specified text in the active file.

Set to Default Sets all settings of the active folder to its default settings.

View
List Mode Displays list mode.

Detail Mode Displays detail mode.

Sort Selects the display sort mode.

Toolbar Shows or hides the Toolbar.

Status Bar Shows or hides the Status Bar.

Font Selects the display font.

Transfer
Retrieve Retrieves the current settings from the device.

Write Writes the settings to the device.
Selects either "All Data" or "Department Codes" only.

Display Log Displays the transfer log.

Tools
Device Address List Opens the Device Address List dialog.

Device Group List Opens the Device Group List dialog.

Options | General Opens the General setting dialog.

Options | FTP 
Configuration

Opens the FTP Settings dialog.

Window Tile Horizontal Arranges the open windows in smaller sizes to all fit in the same
window horizontally.

Tile Vertical Arranges the open windows in smaller sizes to all fit in the same
window vertically.

Cascade Causes all windows to overlap so that each title bar is visible.

Close All Closes all open windows.

Help Help Topics Displays Help Topics.

Supported Models Displays a list of supported models.

About Displays information about Network Configuration Editor / Address
Book Editor.
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Retrieve Data

Basic Operation

1 When Network Configuration Editor or 
Network Address Book Editor is started from 
Network Device Locator or the pre-installed 
shortcut, it connects to the device, retrieves 
the data, and then displays it automatically.

A Process status is indicated in the bottom 
right side of the window.

Note: If the device password is changed 
(Key Operator Code) from the default 
value (000), it is not possible to 
retrieve the data. 
In this case, enter the password in 
advance of  the Default Password in 
the Tools → Options → FTP 
Configuration....

2 If you want to retrieve the latest data from the 

device again, click the  icon, or select 

Retrieve from the Transfer menu.

Note: If the device is in an operating 
condition (copying, printing, etc...), it 
is not possible to retrieve the data 
(Retrieving error). Try again later 
after the device enters the standby 
condition.

Status Indication
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Basic Operation

Edit Data

1 Network Configuration Editor Modify parameters using Network 
Configuration Editor.

When a function is chosen in the left pane of 
the window, the display of the right pane 
changes.

Note: Fields on the left show what items 
have been changed.
*: An item which is different from 

default setting.
#: An item that has been changed.

2 Network Address Book Editor Modify, add or delete Address Book entries 
using Network Address Book Editor.

The type of Address Book to view or work with 
is chosen in the left pane of the window.

Note: (For UF-7000/7100/8000/8100)

The LOWER group of One-Touch 
Keys is designated with an 
asterisk (*) after the number in the 
No. column.
LOWER Group  : 01*, 02*...
UPPER Group  : 01, 02...
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Write Data

1 If you want to write the edited data to the 

device, click the  icon, or select Write 

from the Transfer menu.

2 Select the  button to start writing 

to the device.

3 Process status is indicated in the bottom right 
side of the window.

Note: If the device is in an operating 
condition (copying, printing, etc...), it 
is not possible to write the data 
(Writing error). Try again later after 
the device enters the standby 
condition.

Yes

Status Indication
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Save retrieved data file

Open saved file

Advanced Operation

1 To save the retrieved setting data, click the 

 icon, or select Save As from the File 

menu.

2 To Save File:
1. Select an existing file from the list or 

enter a new file name.

2. Click the  button.
The data is saved to a file.

1 To open a saved file, click the  icon, or 

select Open from the File menu.

Note: To start Network Configuration Editor 
or Network Address Book Editor, 
click [Configuration Editor] or 
[Address Book Editor] without 
selecting the device in the Network 
Device Locator. The editor will open 
without retrieving data from the 
device.

2 To open a file:
1. Select a file from the list.

2. Click the  button.

OK

OK
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Create new file

1 To create a new file, for example to perform 
registration of an address book without 

connecting to the device, click the  icon, 

or select New from the File menu.

Note: To start Network Editor, click 
[Configuration Editor] or [Address 
Book Editor] without selecting the 
device in the Network Device 
Locator. The editor will open without 
retrieving data from the device.

2 The File Information window appears.

Click  to select the model number.

Enter the device name, location and IP 
Address of the device (optional).

Enter the login password (Key Operator Code) 
of the device (optional).

Click the  button.

3 The Save As window appears.

Enter a new file name.

Click the  button.

4 The editing window appears.

Edit items if necessary.

OK

OK
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Advanced Operation

Registering the Device Address List

1 To open the Device Address List, click the 

 icon.

2 Click the:

 button:

To acquire the network address list of the 
Network Device Locator.

 button:

To enter a new address setting into the dialog 
boxes.

 button:

To select the address that you want to edit and 
edit the current settings.

 button:

To select the address that you want to delete.

 button:
To connect the address that you want to 
retrieve and display the data.

 button:

To make the changes effective, and to close 
the window.

 button:
To discard all changes and close the window.

Acquire

Add...

Edit

Delete

Connect

OK

Cancel
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Registering the Group List

1 To open the Device Group List, click the  

icon.

2 The Group Name List lists the registered 
groups.

Click the:

 button:

To create a new group. 

Enter a name and click the  

button.

 button:

To change the name of the selected group.

Enter a new name and click the  

button.

 button:
To delete the selected group.

The Device Address List, lists the addresses 
of registered devices.

Click the:

 button:

To acquire your network address list that is 
detected by Network Device Locator detected.

The Group Member section lists registered 
addresses for the selected group.

Use the   buttons to add or delete the 

selected address from the group members.

New

OK

Update

OK

Delete

Acquire
209
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Advanced Operation

Using the Device Address List and Device Group List

The destination can be specified in the Address Book or Group List.

1 The confirmation window appears before 
retrieving or writing data.

Click the  button.

2 Destionations section:
This shows the addresses currently chosen.

Note: Multiple destinations can be entered 
when only the Dept. Code is selected 
in the Transfer → Write menu. 
[Options...] is indicated when a 
writing option is available.

3 Manual Input tab:

Enter the address and click the  button 

to add the address to the destination.

4 Device Address List tab:

The addresses registered in the Address List 
and Group List are shown.

Select an address, and add or delete it by 

clicking the   or  button.

5 Click the  button to return to the 

confirmation window.

Change Dest.

OK
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Changing the Department Code Counter Data
Follow the procedure below to write the Department Code Counter Data to the device.
.

1 A confirmation window appears before 
retrieving or writing data.

Click the  button.

2 Click the  button.

Note: Click the  button and select 
Dept. Codes and Counter Data to write 
the Department Code Counter Data to 
the device.

3 Select Dept. Codes and Counter Data and 

click the   button.

4 Click the  button to return to the 

confirmation window.

Change Dest.

Options...

Options...

OK

OK
211
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Advanced Operation

Using Timer Communication

Cancel Timer Communication

1 A confirmation window appears before 
retrieving or writing data.

Click the  button.

2 Timer section:
Click Enable and select the time to start the 
communication.

Click the  button to create the job 

and hold it  in the spooler until the specified 
start time.

1 Click the Spooler in the taskbar to open it.

2 If you need to cancel a job, select the job and 
choose Delete from the Spooler menu.

Change Dest.

OK
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Editing the Address Book Editor – Copy and Paste Address Book data 

1 Open the source data file and the target data 
file.
(See page 206, Open saved file)
Select  Window → Tile Horizontal.

2 Select the range that you want to copy.

Click on the first number that you want to copy 
from and then click on the last number that 
you want to copy to, while pressing [Shift] 
key.

or

Click on the first number that you want to copy 
from and drag the mouse to the last number 
you want to copy to.

3 Right-click on the selection and select Copy, 
or select Copy from the Edit menu.
213Continued on the next page...
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Advanced Operation
4 Click on the number where to paste the data.

5 Right-click and select Paste, or select Paste 
from the Edit menu.

6 The data is pasted at the designated location.

Note: The data that exceeds the maximum 
number of allowable address entries 
will be lost.
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Editing Address Book Editor – Import Address Book data from other application

Address Book data created using other applications, such as Microsoft® Excel, can be imported.

1 Copy the Address Book data from the other 
application.

The data format must be an Address (IP 
Address/Fax number/Email Address), and 
Destination Name.

2 Click on the number where to paste the data.

Right-click and select Paste, or select Paste 
from the Edit menu.

3 Data is pasted at the designated location.

Note: The data that exceeds the maximum 
number of allowable address entries 
will be lost.
215
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Troubleshooting

Troubleshooting

If the printing operation fails, check the following items first:

• The connecting cable (USB or Ethernet LAN cable) is properly connected.
• Power of the device is turned ON.
• Paper is loaded properly in the device.
• An error message is not displayed on the device. (See Note 1)

The above points can be verified by printing a test page. Refer to the following pages for the procedures on
test page printing:

NOTE 1. The status of the devices can be verified by the status monitor (see page 187 and 191).

Printing Operation Failure

Windows 98/Windows Me [General Tab]  (See page 42)

Windows NT 4.0 [General Tab]  (See page 50)

Windows 2000/Windows XP/Windows Server 2003 [General Tab]  (See page 59)
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Document is Not Printed Correctly

Problem Possible Cause / Solution(s)
Incorrect printing position or printing
is missing at the edge.

• Paper size or printing orientation is different between the application settings
and the printer driver settings - Specify the settings again.

• The specified paper has not been loaded in the device - Specify the settings
again or load the appropriate paper.

• The document margin is not sufficient. On the machine, a margin of approx. 0.2
inches (5 mm) or more is required at the sheet edges. (Recommended printing
margin)  - Adjust the margin correctly.

Characters and symbols not used in
documents are printed.

Verify that the correct machine has been selected by users as the printer driver.

Printing operation takes excessive
time.

The wait time for printing operations depends on the spool settings.
• Reference :

Windows 98/Windows Me [Details Tab]  (See page 43)
Windows NT 4.0 [Scheduling Tab]  (See page 52)
Windows 2000/Windows XP/Windows Server 2003

[Advanced Tab]  (See page 62)

Although print data is transferred to
the device, it is not printed.

• Make sure the printer is on line.
• Make sure the device is not in the Shutdown Mode. Press ENERGY SAVER

key to return to standby mode. See the Operating Instructions for Copier &
Network Scanner for details.

• Make sure the USB printer cable is connected properly.
• Restore the power if the ON LINE LED is Off even if the USB printer cable is

connected.

Printing stops in the middle of the
run.  

• Check if there is a Network problem.
217
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Error Messages Displayed on the Computer

Problem Possible Cause / Solution(s)
Error writing to USB.
Unable to write to the Specified
device.

Verify that the device is connected to the computer correctly.
Verify that the power of the device is turned On.

Error writing to USB.
Printer timeout error occurred.

Verify that the power of the device is turned On.
Excessive data volume or number of pages may overflow the device's memory,
disabling data reception.
Increase the timeout setting value in properties (for transmission retry).

• Reference :
Windows 98/Windows Me [Details Tab]  (See page 43)
Windows NT 4.0 [Ports Tab]  (See page 51)
Windows 2000/Windows XP/Windows Server 2003

[Ports Tab]  (See page 61)

Printing is disabled due to an error in
the current printer settings.

Differences in settings such as paper size or printing orientation exist between the
application and the printer driver.
Specify the correct settings.
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Appendix

Appendix

When printing to the device, there is a 0.2 inches (5.0 mm) non-printable margin on all 4 sides.

Printing Area

Top

0.2 (5.0)

0.2 (5.0)

0.2 (5.0)0.2 (5.0)

Bottom Unit: inches (mm)
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